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About SonicOS

This guide is a part of the SonicOS collection of administrative guides that describe how to administer and
monitor the SonicWall family of firewalls. SonicOS provides network administrators with the management
interface, API (Application Program Interface), and Command Line Interface (CLI) for firewall configuration. You
can configure and manage your firewall by setting objects to secure and protect the network services, manage
traffic, and provide the desired level of network service. This guide focuses on configuring the monitor settings on
your SonicWall security appliance.

Topics:

* Working with SonicOS

e SonicOS Workflow

¢ How to Use the SonicOS Administration Guides
e Guide Conventions

Working with SonicOS

SonicOS provides a web management interface for configuring, managing, and monitoring the features, policies,
security services, connected devices, and outside threats to your network. SonicOS functions in conjunction with
SonicCore, SonicWall's secure underlying operating system.

The SonicOS management interface facilitates:
» Setting up and configuring your firewall
» Configuring external devices such as access points or switches
» Configuring networks and external system options that connect to your firewall
 Defining objects and policies for protection
» Monitoring the health and status of the security appliance, network, users, and connections
* Monitoring traffic, users, and threats
* Investigating events

SonicWall offers different modes of operation in SonicOS; the modes differ mainly in the areas of policy, object
configuration, and diagnostics.

SonicOS 8 Monitor Administration Guide 7
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e Classic Mode is more consistent with earlier releases of SonicOS; in that you need to develop individual
policies and actions for specific security services. Classic Mode has a redesigned interface.

This following table identifies which of these modes can be used on various SonicWall firewalls:

Firewall Type Classic Mode Comments

TZ Series yes The entry level TZ Series, also known as desktop firewalls,
delivers revamped features such as 5G readiness, better
connectivity options, improved threat protection, SSL and
decryption performance that addresses HTPPS bandwidth
issues; built-in SD-WAN, and lawful TLS 1.3 decryption support. It
provides advanced networking and security features, like the
multi-engine Capture Advanced Threat Protection (ATP) cloud-
based sandbox service with patent-pending Real-Time Deep
Memory Inspection (RTDMI™),

In addition to the management interface, SonicOS also has a full-featured APl and a command-line interface
(CLI) to manage the firewalls.

SonicOS Workflow

When working with SonicWall products, you can use the following workflow as a guide for setting up your security
solution.

Adjust
Monitor & Performance

Planning Configuration Report
Diagnose

Issues

You begin your planning as you start making your purchasing decisions. Your sales partners can help you assess
your network and make recommendations based on the kinds of security services you need. You can learn more
about SonicWall products by reviewing product information and solutions. After selecting the solution, you can
schedule your implementation.

After planning and scheduling your solution, you begin setting up the firewalls. The Getting Started Guides for
your products can help you begin setting up the pieces to your solution. The getting started guides are designed
to help you install the firewall to a minimal level of operation. Before performing any detailed configuration tasks
described in the SonicOS Administration Guides, you should have your firewall set up and basic operation
validated.

The configuration block of the workflow refers to the many tasks that combine to define how your firewall is
integrated into your security solution and how it behaves when protecting your environment. Depending on the
features of your security solution, this task can be quite complex. The System Administration Guides are broken
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into the key command sets and features. Some documents may be used for all solutions, but others may be used
use only if you integrated that feature into your solution. For example, High Availability or Wireless Access Points
are not necessarily used by all customers. More information about a feature's workflow is presented in the feature
administration guide. Refer to the specific Administration Guide for a SonicOS feature for more information.

Configuration tends to be a one-time activity, although you might make minor adjustments after monitoring
performance or after diagnosing an issue. The configuration activity can be broken down into the more detailed
flow as the following figure shows. This also mirrors the key functions that are listed across the top of the
management interface.

HA Configuration
(optional)

Device Network Define Define Validate User
Configuration Configuration Objects Policies Authentication

There is some flexibility in the order in which you do things, but this is the general work-flow you would follow
when configuring your firewall. Start by defining the settings on the firewall. Next you set up the system and other
devices that your firewall is connected to, and you can choose to implement High Availability when done. After
your device, network, and system is configured, you should define the objects that you want to monitor. Then you
use those objects to define the policies that protect your network. The final step to preparing your setup is to
validate the user authentication.

How to Use the SonicOS Administration Guides

The SonicOS Administration Guide is a collection of guides that detail the features represented by each of the
main menu items in the management interface. Within each guide, you can find topics covering commands in that
menu group, along with procedures and in-depth information. The exceptions are the SonicOS 8 Monitor Guide
and the SonicOS 8 Objects Guide which combine the topics for each of those functions into a single book.

To help you understand how the books align with the features and commands, the following figure shows the
books organized like the SonicOS management interface.

SonicOS 8 Monitor Administration Guide 9
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Guide Conventions

These text conventions are used in this guide:

©) | NOTE: A NOTE icon indicates supporting information.

® | IMPORTANT: An IMPORTANT icon indicates supporting information.

@® | TIP: ATIP icon indicates helpful information.

/\ | CAUTION: A CAUTION icon indicates potential damage to hardware or loss of data if instructions

are not followed.

/\ | WARNING: A WARNING icon indicates a potential for property damage, personal injury, or death.

Convention

Bold text

Function | Menu group >
Menu item

Code

<Variable>

Italics

Description

Used in procedures to identify elements in the management interface like
dialog boxes, windows, screen names, messages, and buttons. Also
used for file names and text or values you are being instructed to select or
type into the interface.

Indicates a multiple step menu choice on the user interface. For example,
NETWORK | System > Interfaces means to select the NETWORK
functions at the top of the window, then click on System in the left
navigation menu to open the menu group (if needed) and select
Interfaces to display the page.

Indicates sample computer programming code. If bold, it represents text
to be typed in the command line interface.

Represents a variable name. The variable name and angle brackets
need to be replaced with an actual value. For example in the segment
serialnumber=<your serial number>, replace the variable and brackets
with the serial number from your device, such as
serialnumber=2CB8ED000004.

Indicates the name of a technical manual. Also indicates emphasis on
certain words in a sentence, such as the first instance of a significant term
or concept.

SonicOS 8 Monitor Administration Guide 11
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DASHBOARD

The Dashboard feature is a key function of SonicWall SonicOS, where you can quickly see if anything in your
network is impacting performance. This part of the guide describes the elements of the different views and how
they can be used to drill down to more detailed information. The Dashboard can be your starting place for
monitoring performance. Symbols and colors are used to indicate whether things are operational, need attention,
or if a problem needs to be resolved. Each view provides visibility into the health of the associated network
elements.

Topics:

e System
¢ Access Points
e Capture ATP
e Topology
@ | NOTE: The images in this document may not be an exact match of what you see when you manage your

firewall. The interface you see reflects the type of firewall you chose and the features you configured and
licensed. Specific differences are noted when possible.

SonicOS8MonitorAdministration Guide 12
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System

The System view of the SonicOS Dashboard provides a summary of the information that the firewall. The
navigation path for the System view is HOME > Dashboard > System.

SONIEWALL | | L1111

"B,

SYSTEM STATUS s N Sorting by: Inte

150.52 Kbps
Bandwidth

150.52 Kbps

a

The System view offers a high level view of the system performance. You can select different tabs for different
types of summaries. They include Device, Summary, Security Services, Network, Threat, and DNS Filtering.
Each pane on the tab represents a specific feature being tracked. If you see issues that need more investigation,

you can drill down on the options icon, 5 in the upper right corner. This takes you to other reports that can
help you narrow the source of the issue.

Think of the System view as the starting point for most tasks. From the System page, you can select one of the
tabs to see the data from a specific point of view

SonicOS 8 Monitor Administration Guide 13
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Topics:

©) | IMPORTANT: Zero Touch is not supported in SonicOS when implemented with on-premises Analytics.

For more information about the System option, refer to

Device

HOME | Dashboard > System | Device displays the relevant information for the unit connected to your system.
You have a physical view of the firewall at the top with window, followed by panes that summarize various
information categories.

SONICWALL

\B,, 10700 2 mmmmmmmm
HuRugugrr

GENERAL s us s NETWORK INTERFACES

539.47 Kbps
Bandwidth

El)
Active Connections

CONTENT FILTERING

GBfreeof 178 @

ILABILITY

@ | NOTE: The image above illustrates and NSsp 10700 with the Storage feature. Your firewall view may vary
slightly depending on the features you enabled and the type of firewall you have. For example, if you have
extra storage, you can select Storage option, and see how the storage is distributed among the various logs
as shown below.

Primary [ Available ] 411G
—

stic Data W ConfigurationData [ System Logs W ThrestLogs Packet Captures AppFlow Reports il AuditLogs
ce 737 M8 o8 s 08 1

Secondary [ Available ]
u

W System Logs W ThreatLogs Packet Captures AppFlow Reports [l AuditLogs
568 151M8 634 MB 492K8 LE]
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If you see issues on the dashboard that need more investigation, you can drill down on the options icon, 5 in
the upper right corner. This takes you to other reports that can help you narrow the source of the issue.

Summary

The System Summary —located at HOME | Dashboard > System > Summary, provides a high-level view of
the status of your security infrastructure. It summarizes the activity in easy-to-read, color-coded indicators. You
can review the Summary and see at-a-glance when any issues might need investigating.

INSIGHTS

by DATA RECEIVED INFECTED HOSTS o

CRITICAL ATTACKS 0

0

ENCRYPTED TRAFFIC A
0%

The Summary shows your devices and a representation of the traffic being generated. It allows you to view the

devices in a geographical view using a map that you can zoom in and out of. The devices are marked on the map.

The following table describes the components that make up the System Summary.

Feature Description
Displays all traffic within your infrastructure including threats and their locations.
Provides data as it relates to the users connected to the system.
Provides a high-level view of the overall status of your security infrastructure.
Tracks the number of system connections reporting triggered threats.

Show Top Countries sorted by Sessions

SonicOS 8 Monitor Administration Guide
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Traffic Distribution

The TRAFFIC DISTRIBUTION window displays all traffic within your infrastructure including threats and their
locations. The threats are visually placed on the global map. You can use the roller on your mouse to zoom in or
zoom out on a threat. This kind of data allows you to perform a deep dive on all the information available to you.

General HTTPS MGMT 73%

TRAFFIC DISTRIBUTION shows your devices and a representation of all traffic being generated. This window
allows you to view the devices with a geographical view using a map that you can zoom in and out of. The devices
are marked on the map.

This map provides PRIVATE IPs, FIREWALLS, THREATS, INCOMING TRAFFIC, and OUTGOING TRAFFIC
information.

You can drill-down for more information on the TRAFFIC MAP segment as well. Use the mouse wheel to Zoom in
and out on the global mag or use the vertical + and - slider on the left side of the map. Click the flags and icons on
the map to drill-down for additional details.

SonicOS 8 Monitor Administration Guide 16
System



Top Users

The Top Users report window provides data as it relates to the users connected to the system. You can track

user-level transactions and activities by filtering on several different options, including sessions, bytes received,
bytes sent, and bytes blocked.

TOP USERS

by SESSIONS by BYTES RECEIVED

by BYTES SENT by BLOCKED

SonicOS 8 Monitor Administration Guide 17
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Insights

The Insights window provides a high-level view of the overall status of your security infrastructure. This window
summarizes the activity in easy-to-read, color-coded indicators. You can review the Insights and see at-a-glance
whether any issues need investigation, as well as additional filtering through spotlighting, malware, ransomware,
intrusions, or all the above.

INSIGHTS

INFECTED HOSTS

0

CRITICAL ATTACKS

ENCRYPTED TRAFFIC

ENC Ransomware actively

spreading in the wild

SonicOS 8 Monitor Administration Guide 18
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Observed Threats

Observed Threats tracks the number of system connections reporting triggered threats. The default view is Total
connections, but you can filter with top intrusions, viruses, spyware, and botnets in the Threat drop-down lists.
Navigate to HOME | Dashboard > System > Threat to see the various threat reports available. Click the View
Details icon in each window to expand the available filtering options.

OBSERVED THREATS

0 0

Intrusion Spywar: Botnet Sandbox

SonicOS 8 Monitor Administration Guide 19
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Top Countries

The Top Countries by Sessions report provides data as it relates to the country locations connected to the
system.

TOP COUNTRIES BY SESSIONS

COUNTRY SESSIONS

Private B
H un

You can track location-level transactions and activities by filtering on several different options including Top
Countries by:

SonicOS 8 Monitor Administration Guide 20
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TOP COUNTRIES BY SESSIONS #

COUNTRY SESSIOr Top Countries by Dropped
Private
Unk

Top Countries by Bytes Receivea

’ Top Countries by Bytes Sent

Click View Details to see complete reporting on all Countries located in MONITOR | AppFlow > AppFlow
Report | Location.

Dropped

The Dropped filter indicates the total number of packets or bytes sent (in the Transmit table) or received (in the
Received table) on that interface that were dropped. If the interface is saturated, this number increments one time
for every packet that has been dropped by the server mechanism.

Bytes Received

The Bytes Received filter reports the total bytes received from the host. The bytes received together with the
bytes sent represent the total data transfer on the communications links between the server and the host
computer.

Bytes Sent

The Bytes Sent filter reports the total bytes sent from the host. The bytes received together with the bytes sent
represent the total data transfer on the communications links between the server and the host computer.

SonicOS 8 Monitor Administration Guide 21
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Security Services

Security Services allows the SonicWall firewall to access the Internet through a proxy server to download
signatures to avoid compromising privacy. On the Dashboard, HOME | Dashboard > System | Security
Services summarizes the status of the Security Services that you enabled on your firewall.

1) Refresh

ature Database

On-beox Database Timestamp
Back-end Database Timestamp
Last checked

License Expiration

ignature Database

On-box Database Timestamp
Back-end Database Timestamp
Last checked

License Expiration

BOTNET FILTER @il

Signature Database (0.0.0.0)
On-box Database Timestamp
Back-end Database Timestamp
Last Successful Sync Time

License Expiration

Sync State
Last successful sync time
Last LM contact

License Summary

Last checked

License Expiration

URE ATP @D

License Expiration

ENT FILTER (@

Server Status
30654 hrs License Expiration
306:54 hrs

31

IP FILTER @)
Signature Database (0.0.0.0)
On-box Database Timestamp
Back-end Database Timestamp
Last Successful Sync Time

License Expiration

-
nature Database
On-box Database Timestamp
Back-end Database Timestamp
Last checked

License Expiration

Signature Database

On-box Database Timestamp
Back-end Database Timestamp
Last checked

License Expiration
v

License Expiration

B e

[=J S N X

=]

R

B N B N

o

Each of the panes represents a specific service and provides data on each. Review the table below for the
specifics.

@ | NOTE: You may not see all the options represented here; what you see depends on the options you
enabled.

The Licenses pane show the Sync State of the Security Services license. Last successful sync time and last
contact to License Manager provide additional information. Click the License Summary to see your license
detail. You can also refresh your licenses from this pane.

These features offer a different set of information:
¢ Gateway Anti-Virus
* Intrusion Prevention and Detection
* Botnet Filter
* Geo-IP Filter
¢ Anti-Spyware

¢ Application Control

SonicOS 8 Monitor Administration Guide 22
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From these panes, you can enable and refresh the signatures. You can see the on-box and back-end database
time stamps, along with when the signature was last checked and when the license expires. Note that when an
option is not enabled, like with the Botnet Filter and Geo-IP Filter in the image above, the refresh option is not
visible.

On the Cloud Anti-Virus pane, you can enable or disable the feature. You can also see when the license was
last checked and when it expires.

Capture ATP lets you enable or disable the license and check the license expiration.

You can enable or disable the Content Filter signatures on the Content Filter pane. It shows Server Status and
allows you to refresh the connection. you can also see the license expiration.

The DNS Security pane show when that signature expires.

Network

The Network view provides session reporting windows that display the top Applications, Addresses, Users,
Website Ratings, Countries, and so on.

Topics:

e Top Applications

e Top Addresses

e TopUsers

¢ Top Website Ratings

SonicOS 8 Monitor Administration Guide
System
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Top Applications
The Top Applications window summarizes all applications flowing through the firewall

TOP APPLICATIONS BY SESSIONS

o

29.17K

General SMTP
4.2%

You can view information in Graph form or you can select the List option.

You can track application-level transactions and activities by filtering on several different options. Click on the
setting icon to see the filtering options, including Top Applications by:

» By datareceived
e Bydatasent
» By access rules block
e By app rules block
» By location block
* By botnet block
e By virus
e By intrusion
e By spyware
For more information, you can click on View Details...:

e If operating in Classic Mode, it goes to MONITOR | Logs > Threat Logs.

SonicOS 8 Monitor Administration Guide 24
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Top Addresses

The Top Addresses by Sessions report provides data as it relates to the IP addresses connected to the
system.

TOP ADDRESSES BY S

4\

57.77K

10.60.16.47
4.6%

Click on the List option to see a list view of the data.

You can track IP address-level transactions and activities by filtering on several different options. Click on the
setting icon to see the filtering options, including Top Addresses by:

Blocked

Virus
Spyware
Intrusion
Botnet block
Data received

Data sent

For more information, you can click on View Details...:

If operating in Classic Mode, it goes to MONITOR | Logs > Threat Logs.

SonicOS 8 Monitor Administration Guide 25
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Top Users

The Top Users by Sessions report provides data as it relates to the top users connected to the system.

TOP USERS BY S

703.08K

UNKNOWN
100.0%

Click on the List option to see a list view of the data.

You can track top users and activities by filtering on several different options. Click on the setting icon to see the
filtering options, including Top Users

Blocked

Virus
Spyware
Intrusion
Botnet block
Data received

Data sent

For more information, you can click on View Details...:

If operating in Classic Mode, it goes to MONITOR | Logs > Threat Logs.

SonicOS 8 Monitor Administration Guide 26
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Top Website Ratings

The Top Website Ratings by Sessions report provides data as it relates to the URLs processed through the
system.

TOP WEBSITE RATINGS BY SESSIONS

50.0%

You can view information in Graph form or you can select the List option.
For more information, you can click on View Details...:

 If operating in Classic Mode, it goes to MONITOR | Logs > Threat Logs.

Threat

These reports track the number of connections that have been impacted by threats. You can also filter on other
options listed in the drop-down menus.

Topics:

Top Intrusion

The Top Intrusion by Sessions report provides data as it relates to intrusions processed through the system.
You can select a Graph view or a List view by clicking the appropriate icon.

SonicOS 8 Monitor Administration Guide 27
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You can track intrusion-level transactions and activities by filtering on several different options including Top
Intrusion by:

e Count
¢ Percentage
For more information, you can click on View Details...:

 If operating in Classic Mode, it goes to MONITOR | Logs > Threat Logs.

Top Virus

The Top Virus by Sessions report provides data as it relates to viral threats processed through the system. You
can select a Graph view or a List view by clicking the appropriate icon.

You can track virus-level transactions and activities by filtering on several different options including Top Virus
by:

e Count
e Percentage
For more information, you can click on View Details...:

 Ifoperating in Classic Mode, it goes to MONITOR | Logs > Threat Logs.

Top Spyware

The Top Spyware by Sessions report provides data as it relates to spyware threats processed through the
system. You can select a Graph view or a List view by clicking the appropriate icon.

You can track spyware-level transactions and activities by filtering on several different options including Top
Spyware by:

e Count
¢ Percentage
For more information, you can click on View Details...:

 If operating in Classic Mode, it goes to MONITOR | Logs > Threat Logs.
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Top Botnet

The Top Botnet by Botnet Block report provides data as it relates to botnet threats connected to the system.
You can select a Graph view or a List view by clicking the appropriate icon.

You can track botnet-level transactions and activities by filtering on several different options including Top
Botnet by:

e Blocked

e Virus

e Spyware

e Intrusion

e Bytes received
e Bytes sent

For more information, you can click on View Details...:

 If operating in Classic Mode, it goes to MONITOR | Logs > Threat Logs.

DNS Filtering

The DNS Filtering reports provide an summary and allows you to export the data.

‘ DNS Filtering ‘

37

Negative Reply

TOP MATURE @ Graph =L TOP ENTERPRISE

The DNS Filtering Data pane shows the number of events by category:

SonicOS 8 Monitor Administration Guide
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* Allow

* Block

¢ Negative Reply
e Forge IP

The Top Security pane identifies the malware detected by type. You can select a Graph view or a List view by
clicking the appropriate icon. The categories and counts are provided in either view.

The Top Mature pane identifies the how much adult, or mature, content traverses your network. The categories
and number of events are listed. You can select either a Graph view or a List view of the data by clicking the
appropriate icon.

The Top Enterprise pane identifies the how much content can be identified by Gaming, Social or Sports
enterprises. The categories and number of events are listed. You can select either a Graph view or a List view of
the data by clicking the appropriate icon.

SonicOS 8 Monitor Administration Guide 30
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Access Points

The Access Points view of the SonicOS Dashboard summarizes the information about the access points in the
network. The navigation path for the Access Points view is HOME > Dashboard > Access Points.

The Acess Points view offers a high level view of the performance of the access points in the network. You
canreview the summaries across the top of the page and then scroll to see the different reports.

@® | NOTE: If you have no access points configured, the reports will be blank.

For SonicWave, HOME | Dashboard > Access Points uses charts and graphs to help visualize the data related
to the access points that are connected to your network. You can display both real-time status and historical
status, as well as each client’s rate, OS type, and host name. This Dashboard also displays the status of the
SonicWave devices and provides information to help with monitoring problematic diagnosis.
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A summary of the access points are shown at the top of the page. The data is presented as a doughnut chart;
online is green and offline is red. The Online status includes operational, disabled, rebooting, and in IDS scanning
mode. Offline status includes unresponsive and initializing states.

The count for the Total Wireless Zones, Total Access Points and Total Clients are also displayed.

For more information about the access point, refer to SonicOS 8 Access Points Administration Guide.

Topics:

¢ Feature Limitations

e Access Point Snapshot

¢ Client Association

¢ Real-Time Bandwidth

¢ Client Report

¢ Real-Time Client Monitor

» Client Report and Client Monitor Filtering

Feature Limitations

SonicWave and SonicPoint AC device status is displayed on when the device is managed by a SonicWall firewall.
Both the firewall and the access point needs to be functional or no valid data can be exchanged. SonicWave
access points always retain a seven-day history of the dashboard data. However, because of memory limitations,
SonicPoint AC devices lose all history data when they are rebooted.

Access Point Snapshot

One graph is shown in the Access Point Snapshot section. In the right corner, you can specify the refresh
interval for these charts. Select the number of minutes from the drop-down menu; the options range from 5 to 10
minutes.

Client Association

The Client Association chart shows the number of clients associated with each access pointin the
configuration. The number of users is shown in bar chart form.

Real-Time Bandwidth

A graph showing the bandwidth being used by the selected access point is displayed in the Real-Time
Bandwidth section of the HOME | Dashboard > Access Points.
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@® | NOTE: Only SonicPoint ACe/ACi/N2 and SonicWave devices support the Real-Time Bandwidth feature.

SonicOS shows a stacked chart of the real-time traffic on the selected access point(s). The Y value is the total
traffic, both received and transmitted. By default, all access points are selected for the display.

To select the refresh interval, select the interval period from the drop-down menu by the chart title. Options are: 1
minute, 2 minutes, 5 minutes, 10 minutes, and 60 minutes.

To change the access point being displayed, go to the Access Point drop-down menu and select a different
device. The chart updates with the data for that access point.

Client Report

Three graphs are shown in the Client Report section of the HOME | Dashboard > Access Points: OS Type,
Radio, and Top Client.

@® | NOTE: Only SonicPoint ACe/ACi/N2 and SonicWave devices support the Client Report feature.

Topics:

e OSType
¢ Radio
e Top Client

OS Type

The OS Type pie chart displays the percentages of connected Windows clients, Macintosh clients, Linux clients,
iPhones, Android, and so on. If the client has not generated any HTTP traffic, it might show as Unknown.

@® | NOTE: Only SonicPoint ACe/ACi/N2 and SonicWave devices support the OS Type feature.

Radio

The Client Report also provides a Radio chart. The Radio chart shows the percentage of clients connected to
the 2.4GHz radio and the 5GHz radio.

® | NOTE: Only SonicPoint ACe/ACIi/N2 and SonicWave devices support the Radio feature.

Top Client

The Top Client chart shows the clients who are using the most bandwidth. By going to the TOP field and
selecting a number from the drop-down menu, you can show the top 5, top 10, top 15 or top 20 consumers for
bandwidth. The values for both transmitting and receiving data are shown for the top users.

@® | NOTE: Only SonicPoint ACe/ACI/N2 and SonicWave devices support the Top Client feature.
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Real-Time Client Monitor

A graph showing the client connection details is displayed in the Real-Time Client Monitor section of the HOME
| Dashboard > Access Points. This provides the detail for each user connected through the access points. You
can see MAC addresses, host names, OS type, volume of traffic being received (Rx), and the volume of traffic
being transmitted (Tx).

@ | NOTE: Only SonicPoint ACe/ACi/N2 and SonicWave devices support the Real-Time Client Monitor

feature.

Client Report and Client Monitor Filtering

You can filter the output in both the Client Report section and the Real-Time Client Monitor section by
selecting All or a specific access point in the Access Point drop-down menu, and/or by selecting All or a specific
SSID in the SSID drop-down menu.

@® | NOTE: Only SonicPoint ACe/ACI/N2 and SonicWave devices support client detail filtering.
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Capture ATP

The Capture ATP view of the SonicOS Dashboard, you can quickly see in one place which files are being sent to
the backend for scanning and which ones are being blocked. The navigation path for the Catpure ATP view is
.HOME > Dashboard > Catpure ATP.

™ —m ° & Submit a Sample

VERDICTS FILE TYPES INSIGHTS

Benign Malicious
L] g % OF MALICIOUS FILES

TOTAL FILES SUBMITTED
DYNAMICALLY ANALYZED

0

AVERAGE PROCESSING TIME

OTHERS 0% —————=@

Number of Files

Nov-10 Nov-18 Nov-26

SOURCE IP ADDRESSES ANALYSIS DEPTHS

B Dynamic Analysis Static Analysis

Number of Files

0
Nov - 2 Nov-10 Nov-18 Nov-26

The SonicWall Capture Advanced Threat Protection (Capture ATP) section of DASHBOARD view provides
a cloud-based network sandbox that analyzes suspicious code. By doing so, it helps to discover and stop
ransomware, advanced persistent threats (APTs), and zero-day attacks from entering the network at the gateway
until a verdict is determined. It displays the status of the firmware being used to send files to the backend for
protection.

Capture ATP offers multi-layer sandboxing; including SonicWall's Real-Time Deep Memory Inspection (RTDMI),
full system emulation and virtualization techniques, to analyze suspicious code behavior. It scans traffic,
suspicious code, and a broad range of file sizes and types.
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Grey listed files
Gateway anti-virus
Application control

Judgment
Traffic Botnet filtering
URL filtering
Intrusion prevention
Filtered traffic

@]

Multi-engine SohicWall
Capture Cloud
Featuring RTDMI

For more information about the Capture ATP, refer to SonicOS 8 Capture ATP Administration Guide.

Topics:

e Capture ATP Dashboard
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Topology

The Topology view of the SonicOS Dashboard provides a graphic view of the network. The navigation path for
the Topologyview is Home > Dashboard > Topology.

On the HOME | Dashboard > Topology page, devices can be managed with the Topology feature. Topology
shows the network topology from the SonicWall firewall to the wireless access point. The access point real-time
status can be monitored, and the context menu also provides configuration options.

This feature shows the logical relationship among all WAN. LAN, and WLAN zone devices, and provides a way to
manage devices directly in the Topology.

The HOME | Dashboard > Topology page displays a tree-like or mesh diagram showing connected devices
known to the firewall and their relationships, similar to the following figure:

% | Q, Search Device Name/IP Address/Mac Address. View All (w3 o) g

LN e
~ Ve 2CBSEDS05568

& S 192.168.0.135 v
o
® 10.203.28.1 - g e - - , é
) X1-WaN ) )
1] - 1020328157 2CB3EDEIEC .
| 192 168 168168 S
X0- LAN
a 10.203.28.254 192.168.168.168
Topics:

* Managing the Topology View

e Managing Access Points in the Topology View

Managing the Topology View

The Topology View is a simple interface. It provides the means to keep the view current and to modify the
physical devices in the infrastructure.
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You can also get detailed information on each of the devices in the Topology View. Just run your cursor over the
device and a tool-tip bubble pops up. Depending on the type of device, it shows information like Name, IP
address, Interface, and Model. For access points, you can also see additional information like status and number
of clients.

Each access point also uses color to indicate status:

e Green =online
¢ Red = offline
¢ Yellow = busy

Managing Access Points in the Topology View

The Topology View has a context menu with commands that can be used to manage your access points.
©) | NOTE: Only access points have context menus. None of the other devices in the topology map do.
Topics:

¢ Editing an Access Point
e Showing Statistics
¢ Monitor Status on an Access Point

* Deleting an Access Point

Editing an Access Point

To edit an access point in the Topology View::

—_

Navigate to HOME | Dashboard > Topology.

Roll your mouse over the access point you want to edit.
Right-click on the access point.

Select Edit this Access Point.

Make changes to the object configuration as needed.

o g A w D

Click OK to save new settings.

Showing Statistics

To show statistics for an access point:
1. Navigate to HOME | Dashboard > Topology.

2. Roll your mouse over the access point you want to show.
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Right-click on the access point.

Select Show Access Point Statistics.

Click REFRESH if you want to refresh the statistics.
Click OK when done.

o o &~ w

Monitoring Status on an Access Point

To edit an access point in the Topology View:

1. Navigate to HOME | Dashboard > Topology.

2. Roll mouse over the access point you want to monitor.
3. Right-click on the access point.
4

Select Monitor Access Point Status.

The Access Point Monitor shows system status for the access point. It includes CPU usage, Memory
Usage, Rx Rates and Tx Rates.

Click REFRESH if you want to refresh the data.
6. Click the Details icon if you want to see the details on the access point.

7. Click OK when done.

Deleting an Access Point

To delete an access point in the Topology View:
1. Navigate to HOME | Dashboard > Topology.
2. Roll your mouse over the access point you want to delete.
3. Right-click on the access point.
4. Select Delete Access Point.
5

Confirm that you want to delete the access point; cancel if you do not.
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REAL-TIME CHARTS

System Monitor
Protocol Monitor
User Monitor
Bandwidth Monitor
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The Monitor > Real Time Charts > System Monitor page provides a real-time, multi-functional display with
information about system monitoring, hardware multi-core utilization, application bandwidth usage, interface

usage, and connection usage. rate.

@ | NOTE: A chart may be empty or blank if there are no recent data entries received within the viewing range.
Also note that your charts will vary based on what firewalls and feature you implemented.

Five tabs display the options on the System Monitor page.

System Monitor

System Monitor
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Using the Toolbar

The Policy Monitor toolbar contains features to specify the refresh rate and pause or play the data flow.

Changes made to the toolbar apply across all the data flows.

o G o

PROTOCOL MONITOR TOOLBAR OPTIONS

Option Widget

Range

Pause @
R ©

Tips

re)

Common Features

Topics:

e Legends

¢ Tooltips

e Changing Chart Format

* Selecting IPv6/IPv4

e Current, Minimum, Maximum Display

@ Pause ©

Description

Displays data pertaining to a specific span of
time. The View Range is configurable in 60
seconds, 2 minutes, 5 minutes, and 10
minutes. The default is 2 minutes.

Freezes the data flow. The Pause button
appears black if the data flow has been
frozen.

Unfreezes the data flow. The time entries at
the bottom of the tables will refresh as soon
as the data flow is updated.

The Play button appears black if the data
flow is live.

Mouse over a data point to see values at that
instant.
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Legends

Some charts have the option to display a legend that shows the name and color used for the applications. Simply

enable or disable the switch to Show Legends.

[APPLICATIONS
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Obps.
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Tooltips

Various elements of the charts have associated tool-tips:

The name of most charts hve two tool-tip icons

information in the chart.

1PV4 RATE

Ingressi

0bps

20Mbps
40Mbes
60 Mbps
80Mbes
100 Mbps

Egress@®
Show Legenas: ()

17:10

T —

17m

that briefly describe the ingress and egress

e Legend items display information about the item the legend represents.

0bps

60.0 Kbps

80.0 Kbps

100.0 Kbps

20.0 Kbps III I I II |
40.0 Kbps

15:22

B x
B x5

X9

SonicOS 8 Monitor Administration Guide
System Monitor

44



e Hover over a bar on the chart to see more details on that instance.

b IPV4 RATE
Ingress (i)
60.0 Kbps

20.0 Kbps

20.0 Kbps

Dec 9, 2023, 3:23:45 pm
0bps Total: 15.70 Kbps

B X1-1570 Kbps

0 bps
20.0 Kbps
40.0 Kbps

60.0 Kbps

80.0 Kbps

100.0 Kbps

15:24

To display a tool-tip, hover your mouse over the desired item or click on the chart. The information displayed
varies by chart.

Changing Chart Format

You are able to view individual charts in either stacked bar chart format or single bar chart format. Each chart has

atl

Chart Format icons in the upper right corner of the chart . The default is stack chart format.

Bar Chart

The bar chart format displays applications individually, thus allowing you to compare applications. In this chart,
the applications, interfaces, or core monitors are arranged along the x-axis, for applications and interfaces
according to the color code shown in the Legend. The y-axis displays information appropriate to the chart, such
as the amount of traffic for each application or interface. To display the data in bar chart format, click on the
Stacked Bar icon.

The following example is a Bar Chart view.

APPLICATIONS

a 1Pv4 and IPv6 - All Apps x - m

50.0 Kbps.

0bps.
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Selecting IPv6/IPv4

For complete information on the SonicOS implementation of IPv6, see the chapter on Configuring Interfaces for
Pv6 in the SonicOS 8 System Administration Guide.

Real-Time Charts can be configured to see IPv4, IPv6 and both. Make the selection from the drop-down menu on
the charts where this is an option.

Current, Minimum, Maximum Display

All charts, except Applications, display the current, minimum, and maximum values for the chart. The values
vary by chart and can be in Mbps, Kbps, Pps (packets per second), Bytes, or Cps (connections per second).

Current: 37.9Kbps Min: 2.5Kbps Max: 684.2Kbps Ingress

For the Ingress/Egress charts, the information is displayed for both halves, the Ingress on the top and the
Egress on the bottom. For the other charts, the information is displayed on the top.

Multicore Monitor

The Multicore Monitor displays dynamically updated statistics on utilization of the individual cores of the firewall.
The information is shown either for combined data in stacked bar chart format or for individual cores in bar chart
format. Core 1 through core 8 handle the control plane. The remaining cores handle the data plane. To maximize
processor flexibility, functions are not dedicated to specific cores; instead all cores can process all data plane
tasks. Memory is shared across all cores. Each core can process a separate flow simultaneously, allowing for up
to 88 flows to be processed in parallel.

SonicOS 8 Monitor Administration Guide 46
System Monitor


https://www.sonicwall.com/support/technical-documentation/docs/sonicos-8-0-system

Options

The following option is specific to the Multicore chart. For other options and display features, see Common

Features.

Option
Aggregate Display

Widget

Description

Current (i

Applications Bandwidth

The Applications data flow provides a visual representation of the current applications accessing the network.

Bar Chart

Specifies which Cores are displayed in the
Multi-Core Monitor Flow Chart.

A drop-down menu allows you to specify
Current (Aggregate), Average (Aggregate),
and individual Cores. The individual Cores
vary, depending on the number of Cores
available. Multiple Cores can be selected.

[PPLICATIONS
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show Legends: (@D
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Options

The following option is specific to the Applications chart. For other options and display features, see Common

Features.

Option Widget

Lock H

Unlock E

Interface Usage

Description

Locks the Display for the Applications chart. The
lock/unlock option is available when you select Most
Frequent Apps. Most Frequent Apps displays the top
25 apps; you can use the lock or unlock option to keep
the report from altering the top 25 apps.

Unlocks the Display for the Applications chart.

The Interface Usage charts provide a visual representation of Bandwidth, Packet Rate, and Packet Size. The
current value, plus the minimum and maximum amounts is available in the display. The ingress values are at the
top of the chart and the egress is at the bottom of the chart.

® | NOTE: The Bandwidth charts have no direct correlation to the Application charts.

Stacked Bar Chart

The stacked chart format allows you to view all of traffic as it occurs. The x-axis displays the current time, and the

y-axis displays the .
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Bar Chart

The bar chart format displays data pertaining to individual interfaces in a bar chart; allowing comparisons of

individual interfaces. In this chart, the x-axis denotes the interfaces whereas the y-axis denotes the traffic.

BANDWIDTH
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Obps.
nnnnnn
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Min: 3.5Kbps Max: 23.4Mbps

x2

Options

The following option is specific to the Interface Usage chart. For other options and display features, see

Common Features.

Option
Interface Rate Display

Widget

All Interface Rate =

All Interface Rate

All Interface

Packet Rate Monitor

The Packet Rate monitor provides information on the ingress and egress packet rate as packets per second

Description

Specifies which Interfaces are displayed in
the Bandwidth Flow Chart.

A drop-down menu provides options to
specify All Interfaces Rate, All Interfaces
(%), or rate or percentage (%) for individual

The individual interfaces vary depending on
the number of interfaces on the network.
Multiple interfaces can be selected if desired.

(pps). This can be configured to show packet rate by network interface. The chart shows the current packet rate,
minimum packet rate, and maximum packet rate for both ingress and egress network traffic.

Stacked Bar Chart
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PACKET RATE
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Bar Chart
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Packet Size

The Packet Size report provides information on the ingress and egress packet size in bytes (B). This can be
configured to show packet size by network interface. The chart shows the current packet size, minimum packet
size, and maximum packet size for both ingress and egress network traffic.

Stacked Chart
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Connection Usage

The Connection Usage report is plotted by collecting the outgoing and incoming connection rates for each
interface every refresh period. When looking at the combined connection rate of more than one interface at the
same time, it may appear double than the actual connection rate. A single connection between a pair of interfaces
is counted for both interfaces.
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Stacked Bar Chart
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Topics:

Active Connection Count

Active Connection Count

The Active Connection Count report provides a visual representation of the active total number of connections,
peak number of connections, and maximum number of connections. The y-axis displays the total number of

connections from 0C (zero connections) to 1KC (one kilo connections).

Stacked Chart
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® | NOTE: The Connection Count Monitor does not have legends.
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Protocol Monitor

The Monitor > Real Time Charts > Protocol Monitor page displays real-time charts showing ingress and
egress traffic rates for the following protocols:
IPv4 Rate Internet Protocol version 4

ARP Rate Address Resolution Protocol, used by IPv4 to map IP network addresses to link layer
hardware addresses

IPv6 Rate Internet Protocol version 6

UDP Rate User Datagram Protocol, a connection-less protocol used for example by DNS, SNMP,
RIP, DHCP

TCP Rate Transmission Control Protocol, a connection oriented protocol allowing bidirectional traffic
once the connection is established, used for example by FTP, SSH, Telnet, and also by
DNS

ICMP Rate Internet Control Message Protocol, used by network devices to send error messages and
operational information; ping uses ICMP to send echo request packets to a host

IGMP Rate  Internet Group Management Protocol, used by hosts and routers to establish multicast
group memberships

The seven real-time charts displayed on the Protocol Monitor page are shown in the images below. The Ingres
rate is displayed on the top half of each chart, and the Egress rate is displayed on the bottom.

@® | NOTE: A chart may be empty or blank if there are no recent data entries received within the viewing range.
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PROTOCOL MONITOR - ARP CHART

[ARP RATE

Ingress@
8.0 Kbps.

6.0Kbps

0Kbps
2.0Keps I I I
Obe

Allinterface x -

Obps.
200bps
400bps
600bps

800bps

1000 bps
16:51 16:52 16:53

Egress@

Show Legends: (I

16:55

PROTOCOL MONITOR - IPV6 CHART
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PROTOCOL MONITOR - ICMP CHART

ICMP RATE
Ingress@ Allinterface x -
300.0 bps.
200.0bps.
1000 e
Obps.
Obps.
1000 bps
200.0bpz.
300.0 bps.
400.0 bps.
16:57 16:58 16:59 17:00 17:01

Egress

Show Legends: ()

PROTOCOL MONITOR - IGMP CHART

IGMP RATE
Ingress @ Allinterface x -

800.0bp=
500.0bp=
3000 bp=
2000bp=
Obps
Obps
02bps
04bps
06 bps
08bps

10bps
16:59 17:00 17:01 17:02 17:03

Egress @
Show Legends: ()

Topics:

* Enabling the Protocol Monitor
e Using the Toolbar
* Using Per-Chart Viewing Options

Enabling the Protocol Monitor

The first time you access the Protocol Monitor, it is disabled.

SONICWALL <=

®
(:: 2CB8ED6D73D8 / Monitor / Real-Time Charts / Protocol Monitor

¢ Real-Time Charts
Interface protocol charts are disabled.To enable, please go to Flow Reporting page.
— SystemM

—  Protocol Monitor
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To enable the Protocol Monitor and start displaying statistics in the different charts:

1.

Click on the Flow Reporting page link.

You will be navigated to Device > App Flow > Flow Reporting page.

In the Settings tab, select Interface protocols option from the Collect Real-Time Data For drop-down

and click Accept.

Statistics Settings

AppFlow Agent

[ Ensbing or disabling festures marked with * may require 3 reboot

External Collector SFR Mailing

EXTERNAL FLOW REPORTING STATISTICS

Connection Flows Enqueued
Connection Flows Dequeued

Connection Flows Dropped

Connection Flows Skipped Reporting
Non-Connection data Enqueued
Non-Connection data Dequeued
Non-connection data Dropped
Non-connection related stafic data Reported

Logs Reported by IPFIX

TOTAL IPFIX STATISTICS ©@

Total NetFlow/IPFIX Packets Sent

NetFlow/IPFIX Packets Sent to External
Collector

NetFlow/IPFIX Packets Sent to AppFlow Agent
Netflow/IPFIX Templates sent
Connection Flows Sent to External Collector

Connection Flows Sent to AppFlow Agent

SRR NN RN )

INTERNAL APPFLOW REPORTING STATISTICS

Data Flows Enqueued
Data Flows Dequeued

Data Flows Dropped

Data Flows Skipped Reporting
General Flows Enqueued
General Flows Dequeued
General Flows Dropped
General Static Flows Dequeued
AppFlow Collector Errors

Total Flows in DB

Nen-Connection related Dynamic to External
Collector

Non-Connection related Dynamic to AppFlow
Agent

Non-Connection related Static to External
Collector

Logs Reported by IPFIX to external collector

Non-Connection related Static to AppFlow
Agent

Logs Reported by IPFIX to AppFlow Agent

o

OOEOEeOO e

The settings are enabled, and statistics are displayed in the Protocol Monitor page.

Using the Toolbar

The Protocol Monitor toolbar contains features to specify the refresh rate and pause or play the data flow.
Changes made to the toolbar apply across all the data flows.

o G — o

PROTOCOL MONITOR TOOLBAR OPTIONS

Option Widget

View
Range

Pause

 Smns O

Description

@ Pause ©

Displays data pertaining to a specific span of
time. The View Range is configurable in 60
seconds, 2 minutes, 5 minutes, and 10

minutes (default).

Freezes the data flow. The Pause button
appears black if the data flow has been

frozen.
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Option Widget Description

Play Unfreezes the data flow. The time entries at
the bottom of the tables will refresh as soon
as the data flow is updated.

The Play button appears black if the data
flow is live.

Mouse over a data point to see values at that
instant.

Tips

re)

Using Per-Chart Viewing Options

Topics:

e Legends
¢ Tooltips

Legends

Each chart displays a legend that shows the name and color used for the interfaces selected in the chart’s display
options drop-down menu. To view the chart, select the interfaces from All Interfaces drop-down and toggle the
Show Legends option.

IPV4 RATE

sssss

8.0 Mbps

10.0 Mbps
17:07 17:08 17:00 17:10

Egress®
Show Legends: @0

=3 xo =Ex = x2 "3

x4 B xs X6 | x7

X8 X9 | uw

Tooltips

Various elements of the charts have associated tool-tips:
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The name of each chart has two tool-tip icons that briefly describe the ingress and egress information
in the chart.

1PV4 RATE

obps
obps

20Mbps
40 Mbps
60 Mbps
80Mbes

100 Mbps
17:10 17m

Eoress®
Show Legends: ()

e Legend items display information about the item the legend represents.

0bps = l
ZDDKbpsIII I l II |
40.0 Kbps

60.0 Kbps

80.0 Kbps

100.0 Kbps
15:22

Name

Ir = xi
|- B

X9

e Hover over a bar on the chart to see more details on that instance.

b IPV4 RATE

Ingress (i)
60.0 Kbps

20.0 Kbps

20.0 Kbps.
Dec 9, 2023, 3:23:45 pm
Obps Total: 15.70 Kbps
0 bps B X1-1570 Kbps
20.0 Kbps

40.0 Kbps

60.0 Kbps

80.0 Kbps

100.0 Kbps

15:24

To display a tool-tip, hover your mouse over the desired item or click on the chart. The information displayed
varies by chart.
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User Monitor

The Monitor > Real Time Charts > User Monitor page provides a quick and easy method to monitor the
number of active users on the SonicWall security appliance.

View Style:| Last 30 Minutes V| Vertical Axis: 25 Users v

Q»

NUMBER OF USERS LOGGED IN - LAST 30 MINUTES

[ = Client users [l = Web users
2
2

17
15
12

[
2
[

20 = oz 2 25 2 2 2 M W @ B 17 8 B 14 13 2 1 1. 8 21 New

Time (minutes pas

The User Monitor page provides these options to customize the display of recent user activity in the User
Monitor table:

e View Style: Sets the scale of the X-axis, which displays the duration of time. The available options are:
e Last 30 Minutes

e Last 24 Hours
e Last30 Days

e Vertical Axis: Sets the scale of the Y-axis, which displays the number of users. The available options
reflect the number of users. For example, two different systems would have different options.

EXAMPLE OF OPTIONS FOR Y-AXIS BASED ON NUMBER OF USERS

Few Users

Many Users
10 800
100 8000
1000 80000
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Select User Types icon = Displays a pop-up window, where you can select the types of users to be
displayed, indicated by the associated color.

TTHEUSER T

@) Remote Users with GYC/LZTP Client [ ]
@) Users Authenticated by Web Login [ ]

- Cancel

By default, the above two options are displayed. If you wish to display inactive users and users
authenticated by Single-Sign-On method, navigate to Device > Users > Settings and enable SSO
Agent option and click Accept.

Authentication Web Login Authentication Bypass User Sessions Accounting Customization

USER AUTHENTICATION SETTINGS @

User authentication method Local Users v Case-sensitive user names

Configure RADIUS  ( Configure ) @

P Force relogin after password change
Configure LDAP  ( Configure )

«©
Enforce login uniqueness O

a

a

Display user login info since last login
Configure TACACS+  ( Configurs )

SINGLE-SIGN-ON METHODIS)

Configure S0 { Configure ) RADIUS Accounting
S50 Agent O 3rd-Party API
Terminal Services Agent O Browser NTLM Authentication

ONE-TIME PASSWORD

Enforce password complexity for One-Time Password O
One-time password E-mail format -jé) Plain Text
() HIML

One Time Password Format Characters v

One Time Password Length 10 to | 10 @ Password Strength: Good
=ny )

When SSO Agent is enabled, the options Inactive Users and Users Authenticated by Single-Sign-on
are displayed, indicated by the associated color.

Q

Refresh icon : Refreshes the User Monitor chart.
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Bandwidth Monitor

The Monitor > Real Time Charts > BWM Monitor page displays policy-based bandwidth usage for ingress and
egress network traffic, and a second chart with the top 10 for policy-based bandwidth usage.

The Bandwidth Monitor charts are available for All Policies or for selected policies in the drop-down policies list
next to the chart. The refresh interval rate is configurable from 3 to 30 seconds. The bandwidth management
priority is depicted by guaranteed, maximum, and dropped. The following display settings and configurable
controls are available on this page:

Option Widget Description

View Range o -_ o Displays data pertaining to a

specific span of time. The View
Range is configurable in 60
seconds, 2 minutes, 5 minutes,
and 10 minutes (default).

Refresh every Determines the frequency at
which data is refreshed. A
numerical integer between 1 to 10
seconds is required. The default

is 3 seconds.

Play Unfreezes the data flow. The time
and date will refresh as soon as
the data flow is updated.

Refresh every: 3 sec

The Play button appears black if
the data flow is live.

Pause @ Freezes the data flow. The time
and date will also freeze.

The Pause button appears black
if the data flow has been frozen.
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Option
Stacked Chart

Bar Chart

Policies display

Enabling BWM Monitor

For Classic Mode, bandwidth management policies are configured from the Policy > Rules and Policies >

Widget

All Policies = v

Description

Click the Stacked Bar Chart icon
to display the chart in flow (area)
chart format. The x-axis displays
the current time and the y-axis
displays the amount of ingress
and egress traffic in Mbps.

Click the Bar Chart icon to
display the chart in bar chart
format. The x-axis displays Rules
in the Policy-Based
Ingress/Egress chart and the
names of the top 10 policies for
bandwidth usage in the Policy-
Based Top 10 chart. The y-axis
displays the amount of ingress
and egress traffic in Mbps.

The Policy-Based Top 10 chart is
always displayed as a bar chart
with one bar for each policy.

Specifies which Policies are
displayed in the Policy-Based
Ingress/Egress chart.

A drop-down menu allows you to
specify All Policies or select
individual policies.

The individual policies vary
depending on the configured
policies available. Multiple
policies can be selected.

Access Rules page. To view the BWM chart, edit the access rule for which you want to view the BWM chart and
under Traffic Shaping tab, select the Egress BWM, Ingress BWM, and enable Track Bandwidth Usage

options.
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APPFLOW

e AppFlow Report
» AppFlow Monitor
e CTA Report
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AppFlow Report

The MONITOR | AppFlow > AppFlow Reports page displays the following reports:

© @ N>

REARNENREAS

J Applications. ] Users

Service NTP

151K

Service Version 2 Multicast Listener

* Report (IPvé)

General HTTP
Service RPC Services (IANA)
General HTTP MGMT

Service Echo

105K

347

130

129

B

156.68 KB

B9.24 KB

4.68 MB

33.01KB

13490 KB

4808

15512 KB

0B

338.04 MB

0B

353MB

0B

IP Addresses Virus Intrusions Spyware Locations Botnets Web Categories
¥ | Q search.. IPvd &IPV6 w | | View:Since Restart  w Limit: 50 - = &£ 2 QW #
b SESSIONS INITIATOR BYTES RESPONDER BYTES
£ APPLICATION NAME
COUNT § PERCENTAGE COUNT PERCENTAGE COUNT PERCENTAGE
1 " General HTTPS MGMT 7596K eom— 69% 11380 MB  eomm— 62% 50295MB  comm— 47%
2 General HTTPS 2068K == 18% 6184MB  wmmm 34% 208.14MB == 19%
3 General DNS 917K = 8% 110MB 0% 211MB 0%

0%

0%

32%

0%

0%

0%

The MONITOR | AppFlow > AppFlow Report page enables you to view top-level aggregate reports of what is
going on in your network and, at a quick glance, answer such questions as the following:

What are the top-most used applications running in my network?

Which applications in terms of total number of sessions and bytes consume my network bandwidth?

Which applications have viruses, intrusions, and spyware?

What website categories are my users visiting?

The report data can be viewed from the point of the last system restart or since the data was last reset.

To enable and configure the reports, follow the procedures described in Managing Flow Reporting Statistics in
the SonicOS Logs documentation. The green check mark icon at the top of the MONITOR | AppFlow >

AppFlow Report page displays a link to the DEVICE | AppFlow Settings > Flow Reporting page, where you
can configure the reports.

The top of the page displays the following settings and information:

Q search.

P4 &IPVE ¥

View: Since Restart

-

Limit: 50

v

i= Statistics  §9 Send Report

2 Export  {) Refresh % Column Selection
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e IP Version — Select IPv4, IPv6, or IPv4 and IPv6 to view the reports for that traffic.

¢ View — Choose View type to display reports based on the total activity Since Restart of firewall, activity
Since Last Restart by user of activity based on the configured schedule. If On Schedule then you can
configure to export report either by way of FTP/e-mail.

Choose one:
¢ Since Restart — Shows the aggregate statistics since the last appliance restart.
¢ Since Last Reset — Shows the aggregate statistics since the last time you cleared the statistics.
¢ On Schedule — You can configure to export your report either by FTP or e-mail.
e Limit — Limits the number of resulting entries.

e Check mark — Click or mouse over to expose a popup showing the Appflow Report Status. Links are
provided to connect you to additional data.

APPFLOW REPORT STATUS

Aggregate AppFlow

LICENSED  STATL s TO CONFIGURE..

Refresh — Click to refresh the report data.

Topics:

e Applications

* Users

e |P Addresses
* Viruses

e Intrusions

e Spyware

e Locations

* Botnets

e Web Categories

Applications

Using the View drop-down list, select what you want included in the Applications report. The view type defines
reporting based on the total activity Since Restart of firewall, activity Since Last Reset by user, or activity based
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on the configured schedule. If you select On Schedule, you can configure to export report either via FTP or

email.

When viewing the Applications data, the key information is provided in the table:

Sessions — Number of connections or flows
Initiator Bytes — Number of bytes sent by the initiator

Responder Bytes — Number of bytes sent by the responder

Additionally, the report provides the following information:

Application Name — Name of the application - Signature 1D
Count — The frequency of this application in KBs of the total number of applications.

Percentage of Applications — The frequency of this application as a percentage of the total number of
applications

Access Rules — Number of connections/flows blocked by the firewall rules

App Rules — Number of connections/flows blocked by DPI engine

Location Block — Number of connections/flows blocked by GEO enforcement
Botnet Block — Number of connections/flows blocked by BOTNET enforcement
Virus — Number of connections/flows with virus

Intrusion — Number of connections/flows identified as intrusions

Spyware — Number of connections/flows with spyware

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.

Users

Using the View drop-down list, select Since Restart, Since Last Reset, or On Schedule.

These selections are defined as:

Sessions — Number of sessions/connections initiated/responded
Bytes Received — Number of bytes received by the user

Bytes Sent — Bytes of data sent by the user

The report provides the following information:

User Name — Name of the user, or UNKNOWN

Count — The activity of this user in KBs of the total activity of users

Percentage of Users — The activity of this user as a percentage of the total activity of users
Blocked — Connections/sessions blocked

Virus — Number of connections/flows with virus
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e Spyware — Sessions/connections detected with spyware
¢ Intrusion — Number of Sessions/connections identified as intrusions

¢ Botnet — Sessions/Connections detected as botnetThe columns in the table can be customized so it
displays only what you want to see.

Click the gear icon to select columns.

IP Addresses

Using the View drop-down list, select what you want included in the Applications report. The view type defines
reporting based on the total activity Since Restart of firewall, activity Since Last Reset by user, or activity based
on the configured schedule. If you select On Schedule, you can configure to export report either via FTP or
email.

When viewing the IP Addresses data, the key information is provided in the table:
¢ Sessions — Number of sessions/connections initiated/responded
e Bytes Received — Number of bytes received by the user
e Bytes Sent — Bytes of data sent by the user
The report provides the following information:
e |P Address — The IP address

e Count — The frequency of connections/flows involving this IP address in KBs of the total number of
connections/flows for all IP addresses

e Percentage of IP Addresses — The frequency of connections/flows involving this IP address as a
percentage of the total number of connections/flows for all IP addresses

» Blocked — Connections/sessions blocked

e Virus — Number of connections/flows with virus

* Spyware — Sessions/connections detected with spyware
 Intrusion — Number of Sessions/connections identified as intrusions

¢ Botnet — Sessions/Connections detected as botnet

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.

Viruses

Using the View drop-down list, select what you want included in the Applications report. The view type defines
reporting based on the total activity Since Restart of firewall, activity Since Last Reset by user, or activity based
on the configured schedule. If you select On Schedule, you can configure to export report either via FTP or
email.
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The report provides the following information:
» Sessions — Number of sessions/connections with this virus
The report provides the following information:
¢ Virus Name — The name of the virus, or UNKNOWN
e Count — The frequency of this virus in KBs of the total number of viruses

e Percentage of Viruses — The frequency of this virus as a percentage of the total number of viruses

Intrusions

Using the View drop-down list, select what you want included in the Applications report. The view type defines
reporting based on the total activity Since Restart of firewall, activity Since Last Reset by user, or activity based
on the configured schedule. If you select On Schedule, you can configure to export report either via FTP or
email.

The report provides the following information:
» Sessions — Number of sessions/connections with this virus
The report provides the following information:
¢ Intrusion Name — The name of the intrusion, or UNKNOWN
e Count — The frequency of this intrusion in KBs of the total number of intrusions

» Percentage of Intrusions — The frequency of this intrusion as a percentage of the total number of
intrusions

Spyware

Using the View drop-down list, select what you want included in the Applications report. The view type defines
reporting based on the total activity Since Restart of firewall, activity Since Last Reset by user, or activity based
on the configured schedule. If you select On Schedule, you can configure to export report either via FTP or
email.

The report provides the following information:
» Sessions — Number of sessions/connections with this virus
The report provides the following information:
* Spyware Name — The name of the spyware signature, or UNKNOWN
e Count — The frequency of this spyware in KBs of the total number of spyware

» Percentage of Spyware — The frequency of this spyware as a percentage of the total number of
spyware
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Locations

Applications Users 1P Addresses Virus Intrusions Spyware [ Locations l Botnets Web Categories

%+ | Q search Pvd&IPv6 w | | View:SinceRestart  w = o D Oon

SESSIONS. BYTES RECEIVED BYTES SENT

3 COUNTRY NAME —
COUNT § PERCENTAGE COUNT PERCENTAGE COUNT PERCENTAGE

1 2l Private LEIM — — 06% 254GE eomm— 50% 337GE em— 01%

2 2 Unknown BETOK 3% 61520MB = 19% 35077 MB @ 8%

Using the View drop-down list, select what you want included in the Applications report. The view type defines
reporting based on the total activity Since Restart of firewall, activity Since Last Reset by user, or activity based
on the configured schedule. If you select On Schedule, you can configure to export report either via FTP or

email.

These selections are defined as:
e Sessions — Number of sessions/connections initiated/responded
e Bytes Received — Number of bytes received by the user

e Bytes Sent — Bytes of data sent by the user
The report provides the following information:

e Country Name — Name of the location or country

e Count — The frequency of of connections/flows involving this location in KBs of the total number of
connections/flows for all locations

¢ Percentage of Locations — The frequency of connections/flows involving this location as a percentage
of the total number of connections/flows for all locations

e Dropped — Number of sessions/Connections dropped

Botnets

Using the View drop-down list, select what you want included in the Applications report. The view type defines
reporting based on the total activity Since Restart of firewall, activity Since Last Reset by user, or activity based
on the configured schedule. If you select On Schedule, you can configure to export report either via FTP or

email.
The report provides the following information:
e Botnet Name — Name of the Botnet

¢ Count — Sessions or connections detected as a botnet
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Web Categories

Applications Users IP Addresses Virus Intrusions Spyware Locations Botnets Web Categories

% | Q searcn.. IPV4&IPYE w | | View:SinceRestart  w = e 0 W %

SESSIONS
& RATINGNAME
COUNT 5 PERCENTAGE
Information Technolegy/Computer 155K  emm— 50%
Business and Economy 1524K  om— 49%
‘Web Communications 121 0%

1
2
3
4 Search Engines and Portals 90 0%
5 Computer and intenet Security 8 0%
6

Online Personal Storage 5 0%

Using the View drop-down list, select what you want included in the Applications report. The view type defines
reporting based on the total activity Since Restart of firewall, activity Since Last Reset by user, or activity based
on the configured schedule. If you select On Schedule, you can configure to export report either via FTP or
email.

The report provides the following information:
» Sessions — Number of sessions/connections
The report provides the following information:

¢ Rating Name — The name of URL category

e Count — The frequency of access to URLs in this rating category in KBs of the total number of URL
accesses

* Percentage of Viruses — The frequency of access to URLs in this rating category as a percentage of the
total number of URL accesses
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AppFlow Monitor

The MONITOR | AppFlow > AppFlow Monitor page displays a series of reports. Select the appropriate tab for
one of the reports:

* Applications
* Users

e Web Activity
* |Initiator IPs
e Responder IPs
e Threats

e VoIP

e VPN

* Devices

e Contents

* Policies

The MONITOR | AppFlow > AppFlow Monitor page enables you to monitor top-level aggregate reports of what
is going on in your network and, at a quick glance, answer such questions as the following:

e What are the top-most used applications running in my network?

e Which applications in terms of total number of sessions and bytes consume my network bandwidth?
e Which applications have viruses, intrusions, and spyware?

e What website categories are my users visiting?

To enable and configure the reports, follow the procedures described in Managing Flow Reporting Statistics in
the SonicOS Logs documentation. The green check mark icon at the top of the MONITOR | AppFlow >
AppFlow Monitor page displays a link to the DEVICE | AppFlow Settings > Flow Reporting page, where you
can configure the reports.

The top of the page displays the following settings and information:

+ Create 4 Add to Filter Q Search Puzgipe v O (JRIHGREN) © Group By: Applicaion v 2 Export ) Refresh  ## Column Selection
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e +Create — Click to create filtering on incidents
e +Add to Filter — Click to add filter criteria to selected applications
e IP Version — Select IPv4, IPv6, or IPv4 and IPv6 to view the reports on that traffic.

+ Slider — Use the slider to filter flow results as of the Last 60 secs, 2 minutes, 10 minutes, 15 minutes, 30
minutes, 60 minutes, 3 hours, 6 hours, 12 hours, 24 hours, 7 days, 15 days, 30 days, or All Flows

e Group By - Filters results by grouping flows based on Application, Category, or Signature

e Check mark — Click or mouse over to expose a popup showing the Appflow Monitor Status. Links are
provided to connect you to additional data.

¢ Refresh — Click to refresh the report data.

Applications

J Applications ‘ Users Web Activity Initiator IPs Responder IPs Threats VolP VPN Devices Contents Policies

& & + Q_ Search Putaire w | o () © Group By: Application v [ ]

APPLICATIONS SESSIONS §  TOTAL PACKETS TOTAL BYTES AVERAGE RATE (KBPS)  THREATS

MGMT ¢ Q 51 180.26K 176.03 ke 1404 o

¥ Q 4 720 7208 - [}

' General DNS v Q 1 156K 152K8 0224 o

You can filter flows by Application. Applications can be grouped by Application, Category, or Signature.
These selections are defined as:

e Application — Name of the application - Signature ID

» Sessions — Number of connections or flows

¢ Total Packets — Number of packets

e Total Bytes — Number of bytes sent by the initiator

* Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

e Threats — Number of sessions or connections identified with intrusions, spyware, or a virus.

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.
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Users

Applications Users Web Activity Initiator IPs Responder IPs Threats. VolP VPN Devices Contents Policies

+ Q_ Search Prare v | o (SE)——— O Group By: User Name v [T 3

)&  uses SESSIONS §  TOTALPACKETS  TOTALBYTES AVERAGERATE (KEPS)  THREATS
[ admin ¥ Q 47 183.02¢ 17873 k8 0208 )
[z

unknown ¥ Q 5 172K 168KB 0121 0

The Users report allows filtering by Users. Users can be grouped the following:
e User— Name of the user- Signature ID
» Sessions — Number of connections/flows
e Total Packets — Number of packets

e Total Bytes — Number of bytes sent by the initiator

e Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

e Threats — Number of sessions/connections identified with intrusions/spyware/virus.

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select

columns.

Web Activity

You can filter flows by Web Activity. Web URLs can be grouped by Domain Name, URL, or Ratings.

These selections are defined as:

¢« Domain Name — Name of the web domain

e Add entry to filter — Icon appears allowing you to add specific domain names into your filtering

¢ Sessions — Number of connections or flows
e Total Packets — Number of packets

* Total Bytes — Number of bytes sent by the initiator

» Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

» Threats — Number of sessions/connections identified with intrusions, spyware, or a virus.

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select

columns.
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Initiator IPs

Applications Users Web Activity { Initiator IPs l Responder IPs Threats VolP VPN Devices Contents Policies
% + Q_ Search.. ruespe v | o (o Group By: IP Address v o N &
D 2 INITIATOR IPS SESSIONS § TOTAL PACKETS TOTAL BYTES 'AVERAGE RATE (KBPS) ‘THREATS
[ ¥ Q 48 160.38K 17615 k8 0208 o
- ¥ Q 2 250K 244K8 0223 o
Os ¥ Q 2 360 3608 0070 o

You can filter flows by Initiator IP. Initiator IPs can be grouped by IP Address, Interface, or Country.

These selections are defined as:

¢ Initiator — Name of the initiator IP address

e Add entry to filter — Icon appears allowing you to add specific initiator IP addresses into your filtering

¢ Sessions — Number of connections/flows

¢ Total Packets — Number of packets

e Total Bytes — Number of bytes sent by the initiator

e Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

¢ Threats — Number of sessions/connections identified with intrusions/spyware/virus.

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select

columns.

Responder IPs

Applications Users Web Activity

Initiator IPs Responder IPs Threats

VolP

VPN Devices

Contents Policies

% + Q Search Pusaire v o (IE)—— O
[]s  neseonoemms el e
O ¥ Q 55 205.04K
0= ¥ Q 4 720
[ v Q 2 201
O $ Q 1 503

Group By: IP Address

TOTAL BYTES

20024 KB

7208

196 KB

5038

AVERAGE RATE (KBPS)
0.541
0.070
0.246

0.240

v - M- u

THREATS

°© o o© ©

You can filter flows by Responder IPs. Responder IPs can be grouped by IP Address, Interface, or Country.

These selections are defined as:

e Responder — Name of the responder IP address

e Add entry to filter — Icon appears allowing you to add specific responder IP addresses into your filtering

¢ Sessions — Number of connections or flows

e Total Packets — Number of packets
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e Total Bytes — Number of bytes sent by the initiator
e Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

¢ Threats — Number of sessions/connections identified with intrusions, spyware, or a virus.

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.

Threats

You can filter flows by Threat. Threats can be grouped as All, Intrusion, Virus, Spyware, Anti-Spam, or
Botnet.

These selections are defined as:

e Threat — Name of the threat

e Add entry to filter — Icon appears allowing you to add specific threats into your filtering

» Sessions — Number of connections or flows

e Total Packets — Number of packets

* Total Bytes — Number of bytes sent by the initiator

* Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

» Threats — Number of sessions/connections identified with intrusions, spyware, or a virus

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.

VoIP

You can filter flows by VolIP. VoIP can be grouped as Media Type or Caller ID.
These selections are defined as:
* VolP — Name of the VolP
» Sessions — Number of connections or flows.
¢ Total Packets — Number of packets.
¢ Total Bytes — Number of bytes sent by the initiator.
¢ Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections).
¢ Out of Sequence/Lost Pkts — Number of out of sequence or lost packets.

e Average Jitter (msec) — The average jitter or time delay between when a signal is transmitted and when
itis received. Itis measured in milliseconds.
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Maximum Jitter (msec) — The maximum amount of jitter between when a signal is transmitted and when
it is received, measured in milliseconds.Threats — Number of sessions/connections identified with
intrusions, spyware, or a virus.

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.

VPN

You can filter flows by VPN. VPN can be grouped by Remote IP Address, Local IP Address, or Name.

These selections are defined as:

VPN — Name of the VPN

Sessions — Number of connections/flows

Total Packets — Number of packets

Total Bytes — Number of bytes sent by the initiator

Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

Threats — Number of sessions/connections identified with intrusions/spyware/virus.

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.

Devices

You can filter flows by Device IP address. Devices can be grouped by IP Address, Interface, Name, or Vendor.

These selections are defined as:

Device — Name of the device

Sessions — Number of connections/flows

Total Packets — Number of packets

Total Bytes — Number of bytes sent by the initiator

Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

Threats — Number of sessions/connections identified with intrusions/spyware/virus.

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.
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Contents

You can filter flows by Contents. Content can be grouped by File Type or Email Address.

These selections are defined as:

Content — Name of the content

Sessions — Number of connections/flows

Total Packets — Number of packets

Total Bytes — Number of bytes sent by the initiator

Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

Threats — Number of sessions/connections identified with intrusions/spyware/virus.

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.

Policies

Applica

tions Users ‘Web Activity Initiator IPs Responder IPs Threats VolP VPN Devices Contents Policies

¥
0=
O
(3

+ - [Q seen o@EEE) o Group By Access Rule v o

POLICIES SESSIONS §  TOTAL PACKETS TOTAL BYTES AVERAGE RATE (KBPS)  THREATS
Default Access Rule_15 ¥ Q 54 201.96K 137.23KB 0.356 o

Default Access Rule_4 ¥ Q 2 360 3608 0070 0

You can filter flows by Policies. Seurity Policies can be grouped by Access Rule, NAT Rule, Initiator Route
Policy, or Responder Route Policy.

These selections are defined as:

Policies — Name of the security policy to be monitored

Sessions — Number of connections or flows

Total Packets — Number of packets

Total Bytes — Number of bytes sent by the initiator

Average Rate (KBPS) — Current average rate (calculated over the lifetime of connections)

Threats — Number of sessions/connections identified with intrusions, spyware, or a virus

The columns in the table can be customized so it displays only what you want to see. Click the gear icon to select
columns.
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CTA Report

Use the Capture Threat Assessment (CTA) Report to generate a SonicFlow Report (SFR) that you can download
and post to the Capture Threat Assessment service.

Generate & Download CTA Report

J Generate & Download CTA Report l Advanced Options Completed Reports

| GENERATE

v - e

To generate and post the SonicFlow Report (SFR):

1. Navigate to the Capture Threat Assessment screen on the MONITOR | AppFlow > CTA Report page.
2. Onthe Generate & Download CTA Report tab, click Generate Report.

3. After the report is generated, you have the option to download the report or generate a new one.
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J Generate & Download CTA Report Advanced Options Completed Reports
| o

ENERATE

o rem o

| REPORT

Report

cta-report-2CB8EDE94664-

Filename 5 0201006.pdf

Date  10/6/2020, 9:37:39 PM

Comment  Generated by firewall

4. Click Download Report to download the report.

Advanced Options

The values on the Advance Options tab are not saved to the firewall. Customized data is lost after you log out or
clear your browser cache.

To configure Advanced CTA Report options:

1. Navigate to the MONITOR | AppFlow > CTA Report page.
2. Click the Advanced Options tab.
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4.

Completed Reports

Generate & Download CTA Report

Advanced Options

ADVANCED OPTIONS

Report Title

Company Name

Preparer Name

REPORT TYPE

Executive Summary Only

SELECT SECTIONS

Application Highlights
Risky Applications
Web Activity

File Transfer Investigation

CUSTOM LOGO

PNG in Base 64 Format

O

BRERE

@

Completed Reports

About Text

Contact Phone

Centact Email

Glimpse Of Threats
Malware Analysis
Expolits Used

Known and Unknewn Threats

Provide custom logo image in base64 format

HEEE

D The values in this 12 are not saved in the Frewall Customized data will be lost once you logout or clear your browser cache

Tep ChartMax Count | Auto -

Botnet Analysis
Top Countries By Traffic
Top IPs By Session

Top IPs By Traffic

Preferred Industry | None v

BEEE

Top Users By Session
Top Users By Traffic
Report Configuration

Shadow IT

QEER

Customize data for your CTA Reports using Advanced Options, Report Types, Desired Sections to

appear, or include a customized Report logo.

After completing customized data entries, return to Generate & Download CTA Report and click

Generate Report. The customized Report appears in the Completed Reports tab.

Generate & Download CTA Report

#

I

Search...

Q

FILENAME

Total: 1 item(s)

cta-report-2CB8ED694664-20201006 pdf

DATE

2020/10/06 21:37:39

Advanced Options Completed Reports

LANGUAGE

English

() Refresh

Generated reports appear in the table and are available for download, viewing, and deleting.
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SD-WAN

SD-WAN (Software-Defined Wide Area Network) provides software-based control over wide area network (WAN)
connections.

SD-WAN is best used for specific traffic types and/or applications requiring dynamically chosen optimal
destination interfaces depending on how the network paths are behaving. To operate well, each application has a
certain requirement from the network path. For example, the network quality for VoIP to operate well requires the
optimal latency be 100 ms or less while a latency of 150 ms or higher results in choppy calls. SD-WAN helps in
such scenarios by first dynamically measuring the various network SLA metrics, such as latency, jitter and packet
loss on multiple network paths. SD-WAN then compares these metrics with the SLA threshold for a particular
traffic flow and determines the optimal network that meets the flow’s network quality accordingly.

From MONITOR | SDWAN, you can:
* Monitoring SD-WAN
* Viewing SD-WAN Rules Connections
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@® | NOTE: A chart may be empty or blank if there are no recent data entries received within the viewing range.

Monitoring SD-WAN

@ 2ceseoces

A4 | Viowor | SOWAN

Pl

0 1621 w2 w3 =13 25 1535 77 12 =

A v

To monitor SD-WAN SLA:

e

Navigate to Monitor | SD-WAN > SDWAN Monitor.
From SD-WAN Probes drop-down box, select the SLA probe you would like to use to monitor.
Indicate the Refresh rate, in seconds, in the Refresh Every field.
Select a View Range:
e 60 seconds (default)
* 2 minutes
* 5 minutes
* 10 minutes

Choose an interface to track or select All Interfaces from the drop-down menu on the right side.
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Viewing SD-WAN Rules Connections

You can view the connections that have been associated with SD-WAN Rules on the Monitor | SDWAN > SD-
WAN Connections page.

e To view the activities associated with IPv4 SD-WAN Rules, click IPv4 tab.
e To view the activities associated with IPv6 SD-WAN Rules, click IPv6 tab.

SD-WAN CONNECTION DETAILS

SRC MAC MAC address of the appliance that is the source of the connection.

SRC VENDOR Name of the vendor of the appliance that is the source of the connection.
SRC IP IP address of the appliance that is the source of the connection.

SRC PORT Port on the appliance that is the source of the connection.

DST MAC MAC address of the appliance that is the destination of the connection.
DST VENDOR Name of the vendor of the appliance that is the destination of the connection.
DST IP IP address of the appliance that is the destination of the connection.
DST PORT Port on the appliance that is the destination of the connection.
PROTOCOL Protocol used for the connection.

SRC IFACE Interface on the appliance that is the source of the connection.

DST IFACE Interface on the appliance that is the destination of the connection.

SRC ROUTE Source route of the connection.

DST ROUTE Destination route of the connection.

FLOW TYPE Type of data flow control, such as FTP Control.

IPS CATEGORY

ABR APP ID
ABR CATEGORY ID
EXPIRY (SEC)

Internet Provider Security (IPS) category. If this information is not available or
relevant, the column displays N/A.

App-Based Routing Application ID.
App-Based Routing Category ID.

Number of seconds until the connection expires.

TX BYTES Number of bytes transmitted on the connection.
RX BYTES Number of bytes received on the connection.
TX PKTS Number of packets transmitted on the connection.
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Rx PKTS Number of packets received on the connection.

Flush Displays the Flush icon. Clicking the icon flushes the connection.

Total Total number of entries on the page. This is displayed at the bottom of the page.
You can perform the following actions on the SD-WAN Connections page:

e Tosearch alog, enter a keyword related to an activity in the search bar

* Tofilter the logs, click Filter icon, select the appropriate filter options, and then click APPLY FILTERS.

e Toclear the filters applied, click Clear Filter icon
e To export the logs in CSV or TEXT files, click Export icon and select the required format

* Torefresh the page, click Refresh icon
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LOGS

» System Logs
e Auditing Logs
e Threat Logs
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System Logs

The SonicWall network security appliance maintains an Event log for tracking potential security threats.

Topics:

e Viewing System Logs

e System Log Functions

e Display Options

* Filtering the View

Viewing System Logs

To view system events, navigate to MONITOR | Logs > System Logs page.

> Filter | Q Search...

Q- o) ———o | Lmitso - Configure

& Clear [# Export () Refresh  %§ Grid
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OTHERS.
NOTES

failed in DNS resolve nsm-uswest-
syslog.senicwall.com

VPN Policy: SGMSServer-VPN;
VPN Policy: SGMSServer-VPN:

VPN Policy: SGMSServer-VPN:

VPN Policy: SGMSServer-VEN: 3DES:
HMAE_SHA1_96: DH Group 2: IKEV2 InitSPI
OxB3f41f1a7e717C97; IKEV2 RespSP
0x04193c3be10dcd6e

VPN Policy: SGMSServer-VPN; Local and Peer
gateway are behind 3 NAT device

VPN Policy: SGMSServer-VPN:

VPN Policy: SGMSServer-VPN:

VPN Policy: SGMSServer-VEN; Falied 5 retries; IKEv2
INtSPL 0x609924fddB85DT4; IKEVZ RespSPL
OX6C70a79978CbS0bT

VPN Policy: SGMSServer-VPN:

VPN Policy: SGMSServer-VPN:

VPN Policy: SGMSServer-VPN;
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For a description of the:

e Functions, see System Log Functions

e Columns, see Display Options
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System Log Functions

The System Log table provides numerous settings to allow you to navigate, view, and export results. Table
columns can be customized, so that you can view full data on any event, or only the data you need. Table entries
can be sorted to display in either ascending or descending order.

To sort the entries in the Event Log, click the column heading. The entries are sorted by ascending or descending
order. The arrow to the right of the column name indicates the sorting status. A down arrow means ascending
order. An up arrow indicates a descending order.

The top row of the Event Log contains various functions. Functions pertaining only to Event Logs are described in
the below table.

< Filter | Q Search. Show: Last 5 minutes W = Go to Configure Log ¢® ClearLogs () Refresh [# Export & Grid Settings

| S Filter | Q, Search.. @ o) —————o | umtso ~ = Configure & Clear

2 Export U Refresh  %# Grid |

SYSTEM EVENT LOG FUNCTIONS

Option Function Action

<> Filter Filter Set the filter for any specific log in the Event Log. You can
set the filters based on GENERAL, SOURCE, and
DESTINATION categories. For more information, refer to
Filtering the View.

Search ~ The Event Log displays the log entries that match the

Q, Search...
search string.

 60Secs o Time Set the slider to filter the Event Log based on the time

Interval interval for the Event Log. You can set the slider anywhere
between 60 Sec to 365 days.
) Show Select the interval for the Event Log. The event logs from
Show: last 5 minutes b4 . .

that period are displayed:

¢ Last 60 seconds
¢ Last2 minutes

e Last 5 minutes (default)
¢ Last 10 minutes
¢ Last 15 minutes
¢ Last 30 minutes
¢ Last 60 minutes
e Last 3 hours

e Last6 hours

e Last 12 hours

e Last 24 hours

e Last7days

e Last 15days

e Last30days

e Allentries
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= Configure

¢® Clear

[ Export

Refresh  Click to refresh the system log data.

Configure Click this link and you are navigated to DEVICE | Log >

Log Settings to configure the items which needs to be tracked
in the Event Log.

Clear Click to clear the logs from the table.

Logs

Export Click to export the logs in CSV, TXT files, and email
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Display Options

Customize the Events log to display as many or few columns that meet your needs.

To select which columns to display:

1. Navigate to MONITOR | Logs > System Logs.

2. Click ﬁ Grid Settings icon . The Grid Settings dialog displays:

J Column Selection ‘

+ Select All Columns

b1 General
b2 Interface
» 3 Protocol
b4 Connection
»s Application
» 6 Others

» 7 Operation

@ showor Hide Columns

® Restore Default

SELECTED
5/8
218
/11
0/10
0/5
1/2

1/1

3. Select the items you want to appear as columns in the System Log.

General

General information about the log event.

Time

Category
Group
Event
Msg Type
Priority

Message

Local date and time the event occurred.

@ | IMPORTANT: This option is selected by default. Itis
dimmed, and cannot be deselected.

Identifying number for the event.

@ | IMPORTANT: This option is selected by default. It is
dimmed, and cannot be deselected.

Category of the event. This option is selected by default.
Group designation of the event.
Name of the event.

Type of message; usually Standard Message String.

Priority level of the event, such as Inform (information) or Error.

@® | IMPORTANT: This option is selected by default.

Information about the event.
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Interface

Protocol

Information about the protocol of the packet triggering the event.

Source

Source IP
Source Port
Source Interface

Destination

Destination IP
Destination Port

Destination Interface

Name of the source device, if applicable. This option is
selected by default.

IP address of the source device.
Port number of the source.
Source network and IP address, if applicable.

Name of the destination device, if applicable. This option is
selected by default.

IP address of the destination device.
Port number of the destination.

Destination network and IP address, if applicable.

Information about the NAT policy in effect, if any.

Source Name
Source NAT IP
Source NAT Port
In SPI

Destination Name
Destination NAT IP
Destination NAT Port
Out SPI

IP Protocol

ICMP Type
ICMP Code

Protocol source name.
Source address from the Source NAT IP address pool.
Port number for the Source NAT.

Indicates whether the ingress packet is in Stateful Packet
Inspection (SPI) mode, if applicable.

Protocol destination name.
Destination address from the Source NAT IP address pool.
Port number for the Destination NAT.

Indicates whether the egress packet is in Stateful Packet
Inspection (SPI) mode, if applicable.

Protocol used to send error and control messages, if known.
This option is selected by default.

ICMP packet’s ICMP type, if known.
ICMP packet’s ICMP code, if known.
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Connection Information about SPI, Access and IDP Rules, and policies, if any.

TX Bytes Number of bytes transmitted.
RX Bytes Number of bytes received.
Access Rule Name of the Access Rule triggering the event, if any.
NAT Policy Name of the NAT policy.
VPN Policy Name of the VPN policy triggering the event, if any.
User Name Name of the user whose action triggered the event.
Session Time Duration of the session before the event.
Session Type Type of session triggering the event.
IDP Rule Name of the IDP Rule triggering the event, if any.
IDP Priority Priority of the IDP Rule.
Application Information about the application being used.
HTTP OP NPCS object op requestMethod HTTP OP code.
URL URL of the NPCS object op requestMethod HTTP OP code.
HTTP Result HTTP result code (such as, 200, 403) of Website hit rpkt
cn1Label Packet received.
Block Category Block category that triggered the event.
Application The application being used.
Others Information about the user, session, and application, if known.
FW Action Configured firewall action. If no action has been specified,
displays N/A.
Notes Includes notes. This option is selected by default.

4. When done, click Apply to preserve any changes or click Restore Default to revert back to the default
settings.

You can perform the following actions on the System Logs page:

e To export the logs in CSV, TXT files, and email, click Export icon and select the required format
e Toclear the logs from the table, click Clear Logs icon
e Torefresh the page, click Refresh icon

e To view more details of the log, click the triangle icon of the log

Filtering the View

The Filter View input field at the top left corner of the System Log enables you to narrow your search using drop-
down options and search strings.

To filter the System Event logs:
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Navigate to MONITOR | Logs > System Logs.

Click Filter icon.

E

Select any filtering scheme you want. Filter on just one field or you can filter on all of them. In the General,
Source and Destination fields, you can enter a partial string to filter on.

Click Accept.

OR

Click Reset to clear the filters applied.

SonicOS 8 Monitor Administration Guide 93
System Logs



Auditing Logs

This section describes in detail the recording feature that collects and records information on any changes in the
security appliance configuration. To access this feature, navigate to MONITOR | Logs > Auditing Logs in the
SonicOS web management interface.

What is Configuration Auditing

Configuration auditing is a feature that automatically records any configuration changes that an administrator
attempts from one of the available user interfaces, web management (via HTTP and HTTPS), command line (via
console or SSH), or SonicWall GMS. A configuration auditing records table is created to record all attempted
configuration changes, both successful and failed. With configuration auditing, SonicOS archives the history of its
configuration changes, so that the administrator or others can later revisit and analyze the records. This feature is
enabled by default for the platforms where it is available.

Benefits of Configuration Auditing

Auditing of configuration change records can be useful as described below:

e Automatic documentation of any configuration changes performed by an administrator
e Assistance in troubleshooting unexpected changes in run-time system behavior

¢ Visibility, continuity, and consistency where there are several administrators, either simultaneously or
consecutively. Each administrator has access to a record of changes performed or attempted by all other
administrators.

 Third party integration with Firewall Manager, SEIM systems, logging and reporting solutions

e Compliance with regulations such as SOX, FISMA, NIST, DISA STIP
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What Information is Recorded

Configuration auditing generates a record for every configuration change. The record includes:

Which parameter was changed
When the change was made

Who made the change

From where the change was made

Details of the change, such as the previous and subsequent values

What Information is Not Recorded

The following are not included in the Configuration Auditing operation:

Importing a Settings File - Configuration changes due to importing a settings file are currently not recorded
by the configuration auditing feature. Since all current settings are cleared prior to applying imported
configurations, the assumption is that all existing configurations are modified.

WXA configuration settings — SonicOS does not audit any configuration changes in WAN Acceleration.
Some settings are saved on the WXA instead of the firewall, although the settings can be configured from
the SonicOS web management interface.

ZEBOS settings for BGP/OSPF/RIP routing configurations — SonicOS stores these settings as one long
string of ZEBOS CLI commands. Records of changes made by these commands are not duplicated in the
configuration auditing operation.

Anti-Spam Junk Store applications — Configuration settings changed through a proxy server running a
junk store are excluded from configuration auditing.

Licensing - All aspects of system licensing are authenticated through MySonicWall, and are not recorded
through configuration auditing.

Uploading a file from Home > Capture ATP does not audit uploading a file from the page, because the
contents of this page do not reside on the firewall.

Audit Recording in High Availability
Configurations

The Configuration Auditing operation records changes individually for each device. It does not synchronize the
recorded information between appliances in an HA pair. When the active HA unit next synchronizes with the
standby HA unit, it sends configuration changes to the standby unit. The synchronization operation information

SonicOS 8 Monitor Administration Guide 95
Auditing Logs



updates the auditing record of the standby device in the pair. On the standby unit, the auditing record indicates
that the configuration changes it recorded came from the active unit.

Modifying and Supplementing Configuration
Auditing

Configuration Auditing operations can be modified and supplemented through the following:

SNMP Trap Control

SNMP (Simple Network Management Protocol) is an Internet Standard protocol for collecting and organizing
information about managed devices on IP networks. SNMP traps allow the user to monitor security appliance
status and configuration through a Management Information Database (MIB). Configuration auditing works in
conjunction with SNMP by giving the user the option to enable a trap for each logged event collected during a
network configuration change, whether successful or failed.

E-CLI Commands

E-CLI (Enterprise Command Line Interface) commands are available for configuration auditing record setting and
display, for those administrators who like to work from the command line. You can use the following E-CLI
commands to enable or disable configuration auditing and to view records:

to work with settings:
config(COEAE49CEB84C)# log audit settings
(config-audit)# enable
(config-audit)# debug
(config-audit)# auditall
(config-audit)# commit
to show audit records:

(config-audit)# show log audit view

Auditing Record Storage and Persistence

Configuration auditing records are saved to non-volatile storage (such as flash), so that records can be restored,
if required, after a reboot. The number of records saved is directly proportional to the capability of the device, as
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defined in the product matrix below. Higher-end platforms can store more records than lower-end devices.
Devices with no flash or smaller flash capacity do not support configuration auditing.

All configuration auditing records, on any platform, are deleted when the appliance is rebooted with factory
defaults.

Managing the Audit Logs Table

The administrator can manage the auditing records in many useful ways. The following activities are available:

Topics:
* Viewing Auditing Logs
* Manually Emailing Auditing Logs
* Exporting Auditing Logs
* Refreshing the Auditing Logs
* Displaying the Auditing Logs on the console
* Auditing All Parameters During Addition

Viewing Auditing Logs

The MONITOR | Logs > Auditing Logs page displays all the configuration auditing records. It allows a user to
view, search, and sort the records.

e The first column is expandable to display the summary of the log entry.

e There are also buttons for Select all Columns and Restore Default for ease of operation. Click Grid
Settings icon to perform the desired action.

» The user can search for a specific string pattern and highlight the matched results, if any are found.
 Failed configuration changes are marked in red.

¢ All columns are sortable.

@ 2CBBED4AD260 / Monitor / Logs / Auditing Logs Configuration GNon—Conﬂg

Q Email Audit Records == Supplemental  [# Export ) Refresh  #§ Grid

\ e
& AUDITID § TRANSACTIONID  TIME AUDIT PATH GROUP INDEX GROUP NAME DESCRIPTION OLD VALUE NEW VALUE TRANSACTION ...
sishi2 « Hework e oper | 0P e Succetes

Interfaces
8:47:15 Jul 2 Network Enable HTTPS
X1 managementon  disabled enabled Succeeded
2020 Interfaces
this interface’

»1 o 1

»3 2 1 2;17(’)15'“‘2 X1 rr‘::‘;‘(::s :.::::e:lgncwn disabled enabled Succeeded
this interface!

4o 3 1 Sz X1 et e 0000 105.193.110 Succeeded

»s5 4 1 2;17")15‘“‘2 X1 rr‘::‘;‘(::s E‘:s:f Subnet 255.255.2565.0 255.256.254.0 Succeeded

Ve s x o n e

0000 105.192.1 Succeeded
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Manually Emailing Auditing Logs

When a valid mail server and email address are configured, the user can click the email button on the tool bar of
the Auditing Records page to manually email auditing records at any time. The button is disabled if either the mail
server or the email address is not configured under DEVICE | Log > Automation.

The DEVICE | Log > Automation page includes settings for configuring the SonicWall to send log files using
Email and configuring mail server settings.

I& 2CBBED4AD260 / Monitor / Logs / Auditing Logs Configuration ONon—Conﬁg

Q &% Email Audit Records = Supplemental [4 Export ) Refresh % Grid

& AUDITID § TRANSACTIONID  TIME AUDIT PATH GROUP INDEX

OLD VALUE NEW VALUE TRANSACTION ...
8:47:15 Jul 2
»1 oo 1 vt X1 DHCP static P Succeeded
“Enable HTTPS
47: 1l N k
y2 o1 1 47152 Xt ctworl managementon  disabled enabled Succeeded
2020 Interfaces )
ths interface'
“Enable PING
8:47:15 Jul 2 Network
»3 2 1 o0 x1 e managementon  disabled enabled Succeeded

this interface’

Exporting Auditing Logs

There are two export options for auditing records. You can export the records as a text file or as a CSV file.

-
@ 2CBBED4AD260 / Monitor / Logs / Auditing Logs Configuration (CJJ) Non-Config
Q & Email Audit Records = Supplemental  [4 Export () Refresh &% Grid
BASIC
& AuDTD § TRANSACTIONID  TIME AUDIT PATH ‘GROUP INDEX ‘GROUP NAME DESCRIPTION OLD VALUS INEW VALUE TRANSACTION ..
»1 o 1 21:270‘15]‘”2 X1 m’::‘:;::ts Interface type ' DHCP static IP Succeeded
‘Enable HTTPS
»2 1 1 23'270"5““2 X1 "12‘:;:2:5 managementon  disabled enabled Succeeded
this interface’
. ‘Enable PING
>3 2 1 Sz x1 ek managementon  disabled enabled Succeeded
this interface’

Refreshing the Auditing Logs

The Refresh button provides a way to refresh the page and display the latest auditing records, as seen below:

@ 2CBBED4AD260 / Monitor / Logs / Auditing Logs Configuration (CJJ) Non-Config
Q Email Audit Records = Supplemental 4 Export |Q Refreshl 2% Grid
\ axsc
s AuDTD § TRANSACTIONID  TIME AUDIT PATH ‘GROUP INDEX ‘GROUP NAME DESCRIPTION LD VALUE NEW VALUE TRANSACTION ..
»1 o 1 21;27815 Julz X1 :z:;:::s ‘Interface type DHCP static IP Succeeded
Enable HTTPS
»2 1 1 ‘;:27615]‘”1 X1 :z:;:::s managementon  disabled enabled Succeeded
this interface!
‘Enable PING
»3 2 1 %27(')‘5]“‘2 x1 #‘:;:;:L:S managementon  disabled enabled Succeeded
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Displaying the Auditing Logs on the console

To view the auditing records:

1. Navigate to MONITOR | Logs > Auditing Logs.

2. Click Supplemental > Display Auditing Records on Console option to display the auditing records on

the console in a text format.

Configuration () Non-Config

% Email Audit Records

& 2CBBED4AD260 / Monitor / Logs / Auditing Logs
Q
& AwDITID § TRANSACTIONID  TIME AUDIT PATH GROUP INDEX R
8471512 Net
rr o ! 2020 x Interfaces
8:47:15 u12 Network
bz 1 ! 2020 “ Interfaces
8471512 Network
r3s 2 ! 2020 . Interfaces

‘Interface type
‘Enable HTTPS
management on
this interface’
‘Enable PING
management on
this interface’

= Supplemental  [4 Export () Refresh ## Grid

LUE NEW VALUE TRANSACTION ...
DHCP static 1P Succeeded
disabled enabled Succeeded
disabled enabled Succeeded

Auditing All Parameters During Addition

By default, configuration auditing only logs significant changes, defined as changes where the new value of the

parameter is different from the default value.

To view the updated parameter changes during addition activity:

1. Navigate to MONITOR | Logs > Auditing Logs.

2. Click Supplemental > Audit Supplemental Parameter Changes option to record all parameter
changes during an addition activity, even when the new values are the same as the default values.

I& 2CBBED4AD260 / Monitor / Logs / Auditing Logs Configuration (CJJ) Non-Config
Q Email Audit Records = Supplemental  [4 Export () Refresh &% Grid
¥ AuDITID § TRANSACTIONID ~ TIME AUDIT PATH GROUP INDEX. GR LUE NEW VALUE TRANSACTION ...
47
»1 oo 1 Sz x1 s ‘Interface type'  DHCP static P Succeeded
. Enable HTTPS
»2 o1 1 Sz X1 et managementon disabled enabled Succeeded
this interface’
‘Enable PING
:47:15 Jul
»3 2 1 Sz X1 et managementon disabled enabled Succeeded
this interface’
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Threat Logs

This section describes in detail the recording feature that collects and records information on any changes in the
security appliance configuration. To access this feature, navigate to MONITOR | Logs > Threat Logs in the
SonicOS web management interface.

Q_ search @« o QENE)——o0 | O custom | Limit:50 - 4 Export  ( Refresh 4% Grid

| TIMESTAMP ‘ USERNAME ‘ THREAT TIME ‘ IP ADDRESS

2 TIME USER NAME VIRUS INTRUSION SPYWARE BOTNET START TIME LAST UPDATED INITIATOR IP RESPONDER

Topics:

* Viewing Threat Logs
e Threat Log Functions
¢ Display Options

Viewing Threat Logs

To view threat events, navigate to MONITOR | Logs > Threat Logs page.
For a description of the:
e Functions, see Threat Log Functions

e Columns, see Display Options

Threat Log Functions

The Threat Log table provides numerous settings to allow you to navigate, view, and export results. Table
columns can be customized, so that you can view full data on any event, or only the data you need. Table entries
can be sorted to display in either ascending or descending order.
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To sort the entries in the Event Log, click the column heading. The entries are sorted by ascending or descending
order. The arrow to the right of the column name indicates the sorting status. A down arrow means ascending
order. An up arrow indicates a descending order.

The top row of the Event Log contains various functions. Functions pertaining only to Event Logs are described in
the below table.

Q search ® -0 { LHouw o | O custom | Limit: 50 - 2 Export ) Refresh ¥ Grid

SYSTEM EVENT LOG FUNCTIONS

Option Function Action
Q Search.. Search  The Event Log displays the log entries that
match the search string.
Time Set the slider to filter the Event Log based on
- o Interval  the time interval for the Event Log. You can set
the slider anywhere between 60 Sec to 365
days.
o Custom  Select the interval for the Event Log. The event
O Custom | Limit: 50 v logs displays the maximum entries in the table

based on selection.

< 10

. 25

. 50

« 100

. 250

* 500

« 1000

« 8000 (Max)

) Refresh Refresh  Click to refresh the log data.

L’T Ee Export Click to export the logs.

Display Options
Customize the Events log to display as many or few columns that meet your needs.

To select which columns to display:

1. Navigate to MONITOR | Logs > Threat Logs.

2. Click % Grid icon . The Grid Settings dialog displays:

SonicOS 8 Monitor Administration Guide 101
Threat Logs



J Column Selection ‘
+/ Select All Columns %% Restore Default
' NAME
P 1 Timestamp
P 2 Application
(] URL
p 4 UserName
| 381 Threat
| N3 Time
| s IP Address
] P
[ 3] Port
p 10 Country
P 11 FileMame
p 12 Capture ATP
p 13 Interface
P 14 BWM
p 15 Statistics
b 16 Status
P 17 Puolicies
b 18 MAC
p 19 Miscellaneous
0 Show or Hide Columns.

SELECTED

1/1
2/2
3/3
1/1
4/4
2/2
2/2
1/1
2/2
2/2
1/1
1/1
2/2
2/2
4/4
2/2
77
2/2

5/5

Cancel -

3. Select the items you want to appear as columns in the Threat Log.

Category Name

Timestamp

Application

URL

User Name
Threat

Time

Column
Time
Application
Component
URL

URL Rating
URL Severity
User Name
Virus
Intrusion
Spyware
Botnet

Start Time
Last Updated
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Category Name
IP Address

IP
Port

Country
FileName
Capture ATP
Interface

BWM

Statistics

Status

Policies

MAC

Miscellaneous

4. When done, click Apply to preserve any changes or click Restore Default to revert back to the default

settings.

Column

Initiator IP
Responder IP
Protocol Name
Initiator Port
Responder Port
Initiator

Responder
FileName

Action

Initiator Interface
Initiator Interface
Inbound Priority
Outbound Priority
All Counters

Initiator Bytes
Responder Bytes
Flow Status

Blocked Reason
Security Rule

NAT Rule

Init Route Rule

Resp Route Rule
Decryption SSL Rule
Decryption SSH Rule
DoS Rule

Init MAC

Responder MAC
Initiator Gateway
Responder Gateway
Initiator VPN Name
Gateway VPN Name
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TOOLS AND MONITOR

Using Packet Monitor
Viewing Connections
Monitoring Core 0 Processes
Using Packet Replay
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Using Packet Monitor

The Packet Monitor is a mechanism that allows you to monitor individual data packets that traverse your
SonicWall network security appliance. Packets can be either monitored or mirrored. The monitored packets
contain both data and addressing information. Addressing information from the packet header includes the
following:

 Interface identification

¢ MAC addresses

e Ethernet type

 Internet Protocol (IP) type

* Source and destination IP addresses
e Port numbers

e L2TP payload details

e PPP negotiations details

You can configure the packet monitor feature in the enhanced management interface. The management
interface provides a way to configure the monitor criteria, display settings, mirror settings, and file export settings,
and displays the captured packets.

Current configurations are displayed on this page, hover over the information symbols to view the details.

Topics:

» Benefits of Packet Monitor

e How Does Packet Monitor Work?

* Supported Packet Types

e Configuring Packet Monitor

* Monitoring Captured Packets

¢ Viewing Packet Monitoring Statistics
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Benefits of Packet Monitor

The packet monitor feature provides the functionality and flexibility that you need to examine network traffic
without the use of external utilities, such as Wireshark (formerly known as Ethereal). Packet monitor includes the
following features:

» Control mechanism with improved granularity for custom filtering (Monitor Filter)
* Display filter settings independent from monitor filter settings
e Packet status indicates if the packet was dropped, forwarded, generated, or consumed by the firewall
e Three output displays in the management interface:
e Listof packets
e Decoded output of selected packet
e Hexadecimal dump of selected packet

e Export capabilities include text or HTML format with hex dump of packets, plus CAP file formats, pcap and
pcapNG

¢ Automatic export to FTP server when the buffer is full
¢ Bidirectional packet monitor based on IP address and port

¢ Configurable wrap-around of packet monitor buffer when full

How Does Packet Monitor Work?

As an administrator, you can configure the general settings, monitor filter, display filter, advanced filter settings,
and FTP settings of the packet monitor tool. As network packets enter the packet monitor subsystem, the monitor
filter settings are applied, and the resulting packets are written to the capture buffer. The display filter settings are
applied as you view the buffer contents in the management interface. You can log the capture buffer to view in the
management interface, or you can configure automatic transfer to the FTP server when the buffer is full.

Default settings are provided so that you can start using packet monitor without configuring it first. The basic
functionality is:

PACKETS: BASIC FUNCTIONALITY

Start: Click Start Capture to begin capturing all packets except those used for communication between
the firewall and the management interface on your console system.

Stop: Click Stop Capture to stop the packet capture.

Refer to Configuring Packet Monitor for a high-level view of the packet monitor subsystem that shows the
different filters and how they are applied.
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PACKET MONITOR SUBSYSTEM SHOWING FILTERS

Display filter is applied
before displaying packets
‘o the management interface.

<—————— Capture Buffer H———>»

Remote FTP Server Management Host

Monitor filter is applied ——

before copying the packet

into the capture buffer.

P Packets

- Incoming
- Qutgoing
- Generated
- Intermediate

Supported Packet Types

When specifying the Ethernet or IP packet types that you want to monitor or display, you can use either the
standard acronym for the type, if supported, or the corresponding hexadecimal representation. To determine the
hex value for a protocol, refer to the RFC for the number assigned to it by IANA.

Protocol
Supported Types Acronyms Notes
ARP To specify both PPPoE-DIS and PPPoE-SES, you can simply
use PPPOE.
e IP
¢ PPPoOE-DIS

¢ PPPoOE-SES
Supported IP Types ¢ TCP

Supported Ethernet
Types

« UDP

e ICMP
* IGMP
* GRE

e AH

e ESP

Configuring Packet Monitor

You can access the packet monitor tool on the Monitor > Tools & Monitors > Packet Monitor page of the
management interface. There are six main areas of configuration for packet monitor, one of which is specifically
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for packet mirror. The following sections describe the configuration options, and provide procedures for
accessing and configuring the filter settings, log settings, and mirror settings:

Topics:

e Configuring General Settings
* Monitoring Captured Packets
« Viewing Packet Monitoring Statistics

Configuring General Settings

Topics:

e Configuring General Settings

» Configuring the Monitor Filter

e Configuring Display Filter Settings

» Configuring Logging Settings

e Configuring Advanced Monitor Filter Settings
» Configuring Mirror Settings

Configuring General Settings

This section describes how to configure packet monitor general settings, including the number of bytes to capture
per packet and the buffer wrap option. You can specify the number of bytes using either decimal or hexadecimal,
with a minimum value of 64. The buffer wrap option enables the packet capture to continue even when the buffer
becomes full, by overwriting the buffer from the beginning.
To configure the general settings:

1. Navigate to the Monitor > Tools & Monitors > Packet Monitor page.

2. Selectthe General tab.

3. Select the Settings tab.
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Captured Packets General Statistics

Settings Monitor Filter Display Filter Logging Advanced Monitor Filter Mirror

GENERAL SETTINGS
Number Of Bytes To Capture (per packet) 1520 @

Wrap Capture Buffer Once Full O @

Enable logging to Storage O @

EXCLUDE FILTER

Exclude encrypted GMS traffic o @
Exclude Management Traffic E] HTTRHTTPS @

[] snmp
(] ssH

Exclude Syslog Traffic to D Syslog Servers @
E] GMS Server

Exclude Internal Traffic for Ha @

|/ Default jll( Cancel ) -

4. Inthe Number of Bytes To Capture (per packet) box, type the number of bytes to capture from each
packet. The minimum value is 64 and the maximum value is 65535.

5. To continue capturing packets after the buffer fills up, select Wrap Capture Buffer Once Full. Selecting
this option causes packet capture to start writing captured packets at the beginning of the buffer again
after the buffer fills. This option has no effect if FTP server logging is enabled on the Logging tab,
because the buffer is automatically wrapped when FTP is enabled.

6. Under Exclude Filter, select Exclude encrypted GMS traffic to prevent capturing or mirroring of
encrypted management or syslog traffic to or from SonicWall GMS. This setting only affects encrypted
traffic within a configured primary or secondary GMS tunnel. GMS management traffic is not excluded if it
is sent through a separate tunnel.

7. Use the Exclude Management Traffic settings to prevent capturing or mirroring of management traffic to
the appliance. Select the checkbox for each type of traffic (HTTP/HTTPS, SNMP, or SSH) to exclude. If
management traffic is sent through a tunnel, the packets are not excluded.

8. Use the Exclude Syslog Traffic to settings to prevent capturing or mirroring of syslog traffic to the
logging servers. Select the checkbox for each type of server (Syslog Servers or GMS Server) to exclude. If
syslog traffic is sent through a tunnel, the packets are not excluded.

9. Use the Exclude Internal Traffic for settings to prevent capturing or mirroring of internal traffic between
the SonicWall network security appliance and its High Availability partner or a connected SonicPoint.
Select the checkbox for each type of traffic (HA, SonicPoint, BCP, Inter-Blade, or Back-Plane) to exclude.

10. To save your settings and exit the configuration window, click Save.

Configuring the Monitor Filter

All filters set on the Monitor Filter page are applied to both packet capture and packet mirroring.
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To configure Monitor Filter settings:
1. Navigate to the Tools & Monitors > Packet Monitor page.
2. Selectthe General tab.
3. Select the Monitor Filter tab.

Captured Packets General

Settings Menitor Filter Display Filter Logging Advanced Moenitor Filter Mirror

Statistics

MONITOR FILTER (USED FOR BOTH MIRRORING AND PACKET CAPTURE)

Enable filter based on the security policy fapp rule O @

Interface Name(s)
Ether Type(s)

IP Typels)

Source IP Address(es)
Source Port(s)

Destination IP Address|es)

® & ©& © © © ©

Destination Port(s)

Enable Bidirectional Address and Port Matening (I ) @

Monitor (Leave all checkboxes unchecked for normal operation. Unchecked means capture all

Forwarded packets onby
type of packets.) D

D Consumed packets only

D Dropped packets only

T e RO o
I Default RN Cancel A -

4. Choose Enable filter based on the firewall/app rule if you are using firewall rules to capture specific
traffic.
Before the Enable filter based on the firewall rule option is selected, be certain you have selected one
or more access rules on which to monitor packet traffic. This configuration is done from the POLICY
> Rules and Policies > Access Rules page.

5. Specify how Packet Monitor filters packets using these options:

e Interface Name(s) - You can specify up to ten interfaces separated by commas. Refer to the
Network > Interfaces page in the management interface for the available interface names. You
can use a negative value to configure all interfaces except the one(s) specified; for example: X0,
orILAN.

» Ether Type(s) - You can specify up to ten Ethernet types separated by commas. Currently, the
following Ethernet types are supported:

« ARP
. IP

- PPPOE-SES
« PPPOE-DIS
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The latter two can be specified by PPPoOE alone.

This option is not case-sensitive. For example, to capture all supported types, you could enter: aArp,
1P, PPPOE. YOU can use one or more negative values to capture all Ethernet types except those
specified; for example: ' ARP, ! PPPoE. You can also use hexadecimal values to represent the
Ethernet types, or mix hex values with the standard representations; for example: arp, 02800, TP.
Normally, you would only use hex values for Ethernet types that are not supported by acronym in
SonicOS. (Refer to Supported Packet Types for more information.)

IP Type(s) - You can specify up to ten IP types separated by commas. These IP types are
supported:

. TCP

- UDP

* ICMP
* GRE

* IGMP
* AH

« ESP

You can use one or more negative values to capture all IP types except those specified; for
example: ITCP, IUDP. You can also use hexadecimal values to represent the IP types, or mix hex
values with the standard representations; for example: Tcp, 0x1, 0x6. (Refer to Supported Packet
Types for more information.) This option is not case-sensitive.

Source IP Address(es) - You can specify up to ten IP addresses separated by commas; for
example: 10.1.1.1,192.2.2.2. You can use one or more negative values to capture packets from all
but the specified addresses; for example: 110.3.3.3, 110.4.4.4.

Source Port(s) - You can specify up to ten TCP or UDP port numbers separated by commas; for
example: 20, 21, 22, 25. You can use one or more negative values to capture packets from all but
the specified ports; for example: 80, !18080.

Destination IP Address(es) - You can specify up to ten IP addresses separated by commas; for
example: 10.1.1.1,192.2.2.2. You can use one or more negative values to capture packets
destined for all but the specified addresses; for example: 110.3.3.3,110.4.4.4.

Destination Port(s) - You can specify up to ten TCP or UDP port numbers separated by commas;
for example: 20, 21, 22, 25. You can use one or more negative values to capture packets destined
for all but the specified ports; for example: 180, !8080.

Enable Bidirectional Address and Port Matching - When this option is selected, IP addresses
and ports specified in the Source or Destination fields on this page are matched against both the
source and destination fields in each packet.

Forwarded packets only - Select this option to monitor any packets that are forwarded by the
firewall.

Consumed packets only - Select this option to monitor all packets that are consumed by internal
sources within the firewall.
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* Dropped packets only - Select this option to monitor all packets that are dropped at the

perimeter.

@ | NOTE: If a field is left blank, no filtering is done on that field. Packets are captured or mirrored
without regard to the value contained in that field of their headers.

6. To save your settings and exit the configuration window, click Save.

Configuring Display Filter Settings

This section describes how to configure packet monitor display filter settings. The values that you provide here

are compared to corresponding fields in the captured packets, and only those packets that match are displayed.

These settings apply only to the display of captured packets on the management interface, and do not affect

packet mirroring.

If a field is left blank, no filtering is done on that field. Packets are displayed without regard to the value contained

in that field of their headers.

To configure Packet Monitor display filter settings:

1. Navigate to the Monitor > Tools & Monitors > Packet Monitor page.

2. Select the General tab.
3. Select the Display Filter tab.

Captured Packets General } Statistics

Settings Monitor Filter Display Filter Logging Advanced Monitor Filter Mirror
SHOW (DISPLAY) FILTER (USED FOR Ul DISPLAY ONLY)
Interface Name(s) X0
Ether Type(s)
IP Type(s) TCP

Source IP Address(es)
Source Port(s)
Destination IP Address(es)

Destination Port(s)

Enable Bidirectional Address and Port Matching O @

¢ Default )f Cancel )

Include Forwarded packets in the display
Generated packets in the display
@ Consumed packets in the display

Dropped packets in the display

©® ® & e © e ©

4. Inthe Interface Name(s) box, type the SonicWall network security interfaces for which to display packets,

or use the negative format (IX0) to display packets captured from all interfaces except those specified.

You can specify up to ten interfaces separated by commas. Refer to the Network > Interfaces screenin

the management interface for the available interface names.
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5.

10.

11.

12.
13.

In the Ether Type(s) box, enter the Ethernet types for which you want to display packets, or use the
negative format (! arp) to display packets of all Ethernet types except those specified. You can specify up
to ten Ethernet types separated by commas. Currently, these Ethernet types are supported:

* ARP
- IP
« PPPOE-SES

* PPPOE-DIS
The latter two can be specified by PPPoE alone.

You can also use hexadecimal values to represent the Ethernet types, or mix hex values with the standard
representations; for example: ArRP, 0x800, 1p. Normally, you would only use hex values for Ethernet types
that are not supported by acronym in SonicOS. (Refer to Supported Packet Types for more information.)

In the IP Type(s) box, enter the IP packet types for which you want to display packets, or use the negative
format (IUDP) to display packets of all IP types except those specified. You can specify up to ten IP types
separated by commas. These IP types are supported:

. TCP
« UDP

« ICMP
« GRE

. IGMP
e AH

e« ESP
You can also use hexadecimal values to represent the IP types, or mix hex values with the standard
representations; for example: Tcp, 0x1, 0x6. To display all IP types, leave blank. (Refer to Supported
Packet Types for more information.)

In the Source IP Address(es) box, type the IP addresses from which you want to display packets, or use
the negative format (1 10.1.2.3) to display packets captured from all source addresses except those
specified.

In the Source Port(s) box, type the port numbers from which you want to display packets, or use the
negative format (!25) to display packets captured from all source ports except those specified.

In the Destination IP Address(es) box, type the IP addresses for which you want to display packets, or
use the negative format (1 10.1.2.3) to display packets with all destination addresses except those
specified.

In the Destination Port(s) box, type the port numbers for which you want to display packets, or use the
negative format (!80) to display packets with all destination ports except those specified.

Select Enable Bidirectional Address and Port Matching to match the values in the source and
destination fields against either the source or destination information in each captured packet.

Select Forwarded to display captured packets that the SonicWall network security appliance forwarded, .

Select Generated to display captured packets that the SonicWall network security appliance generated.
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14. Select Consumed to display captured packets that the SonicWall network security appliance consumed.
15. Select Dropped to display captured packets that the SonicWall network security appliance dropped, .

16. To save your settings and exit the configuration window, click Save.

Configuring Logging Settings

This section describes how to configure Packet Monitor logging settings. These settings provide a way to
configure automatic logging of the capture buffer to an external FTP server. When the buffer fills up, the packets
are transferred to the FTP server. The capture continues without interruption.

If you configure automatic FTP logging, this supersedes the setting for wrapping the buffer when full. With
automatic FTP logging, the capture buffer is effectively wrapped when full, but you also retain all the data rather
than overwriting it each time the buffer wraps.
To configure logging settings:

1. Navigate to the Monitor > Tools & Monitors > Packet Monitor page.

2. Selectthe General tab.

3. Select the Logging tab.

Captured Packets [ General 1 Statistics

Settings Monitor Filter Display Filter Logging Advanced Monitor Filter Mirror

LOGGING

FTP Server IP Address

Login ID admin

P -

®& © © ©

Directory Path captures

Log To FTP Server Automatically O @
Log PCAPNG File To FTP Server o ®

Log HTML File Along With cap File (FTP) o ®

S

Log Now

4. Inthe FTP Server IP Address box, type the IP address of the FTP server.

@ | NOTE: Make sure that the FTP server IP address is reachable by the SonicWall network security
appliance. An IP address that is reachable only through a VPN tunnel is not supported.

( Default

LN

\I
J

5. Inthe Login ID box, type the login name that the SonicWall network security appliance should use to
connect to the FTP server.

6. Inthe Password box, type the password that the SonicWall network security appliance should use to
connect to the FTP server.
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7. Inthe Directory Path box, type the directory location for the transferred files. The files are written to this
location relative to the default FTP root directory.

For libcap format, files are named packet-1og--<>.cap, Where the <> contains a run number and date
including hour, month, day, and year. For example, packet-10og--3-22-08292006.cap.

8. For HTML format, file names are in the form packet-1log_h-<>.html. Forexample, an HTML file name is:
packet-log h-3-22-08292006.html.

9. Select Log To FTP Server Automatically to enable automatic transfer of the capture file to the FTP
server when the buffer is full. Files are transferred in both libcap and HTML format.

10. Select Log HTML File Along With .cap File (FTP) to enable transfer of the file in HTML format as well as
libcap format.

11. Click Log Now to test the connection to the FTP server and transfer the capture buffer contents to it.
12. Forexample, packet-log-F-3-22-08292006.cap Of packet-log h-F-3-22-08292006.html.

13. To save your settings and exit the configuration window, click Save.

Configuring Advanced Monitor Filter Settings

This section describes how to configure monitoring for packets generated by the SonicWall network security
appliance and for intermediate traffic.

To configure the Advanced Monitor Filter settings:
1. Navigate to Tools & Monitors > Packet Monitor.
2. Click the General tab.
3. Click the Advanced Monitor Filter tab.

Captured Packets General Statistics

Settings Monitor Filter Display Filter Logging Advanced Monitor Filter Mirror

ADVANCED FILTER

Monitor Firewall Generated Packets (This will bypass interface fiter) () (@
Monitor Intermediate Packets (1 (D

Moniter intermediate multicast trafic (&
Monitor intermediate IF helper traffic (D)
Moniter intermediate reassembled traffic (@)
Monitor intermediate fragmented traffic  (3)
Moniter intermediate remote mirrored traffic (@
Monitor intermediate IPsec tratfic (D)
Meniter intermediate SSL decrypted traffic (D)
Restare original ports on SSL decrypted traffic ()
Monitor intermediate decrypted LDAP over TLS packets (@

Monitor intermediate decrypted Single Sign On agent/lient messages @

(o) (o) D

4. To monitor packets generated by the SonicWall network security appliance, select Monitor Firewall
Generated Packets.

SonicOS 8 Monitor Administration Guide 115
Using Packet Monitor



5. Even when other monitor filters do not match, this option ensures that packets generated by the SonicWall
network security appliance are captured. This includes packets generated by HTTP(S), L2TP, DHCP
servers, PPP, PPPOE, and routing protocols. Captured packets are marked with ‘s’ in the incoming
interface area when they are from the system stack. Otherwise, the incoming interface is not specified.

6. To monitor intermediate packets generated by the SonicWall network security appliance, select Monitor
Intermediate Packets. Selecting this checkbox enables, but does not select, the subsequent checkboxes
for monitoring specific types of intermediate traffic. Select the checkbox for any of the following options to
monitor that type of intermediate traffic:

Monitor intermediate multicast traffic — Capture or mirror replicated multicast traffic.

Monitor intermediate IP helper traffic — Capture or mirror replicated IP Helper packets.
Monitor intermediate reassembled traffic — Capture or mirror reassembled IP packets.
Monitor intermediate fragmented traffic — Capture or mirror packets fragmented by the firewall.

Monitor intermediate remote mirrored traffic — Capture or mirror remote mirrored packets after
de-encapsulation.

Monitor intermediate IPsec traffic — Capture or mirror IPSec packets after encryption and
decryption.

Monitor intermediate SSL decrypted traffic — Capture or mirror decrypted SSL packets. Certain
IP and TCP header fields might not be accurate in the monitored packets, including IP and TCP
checksums and TCP port numbers (remapped to port 80). DPI-SSL must be enabled to decrypt the
packets.

7. Restore original ports on SSL decrypted traffic — Select to restore the original TCP ports from the
encrypted connection in the SSL decrypted packets.

Monitor intermediate decrypted LDAP over TLS packets — Capture or mirror decrypted
LDAPS packets. The packets are marked with “(Idp)” in the ingress/egress interface fields and has
dummy Ethernet, IP, and TCP headers with some inaccurate fields. The LDAP server is set to 389.
Passwords in captured LDAP bind requests are obfuscated.

Monitor intermediate decrypted Single Sign On agent/client messages — Capture or mirror
decrypted messages to or from the SSO Agent. The packets are marked with “(sso)” in the
ingress/egress interface fields and has dummy Ethernet, IP, and TCP headers with some
inaccurate fields.

©) | NOTE: Monitor filters are still applied to all selected intermediate traffic types.

8. To save your settings and exit the configuration window, click Save.

Configuring Mirror Settings

This section describes how to configure Packet Monitor mirror settings. Mirror settings provide a way to send
packets to a different physical port of the same firewall or to send packets to, or receive them from, a remote
SonicWall network security appliance.
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To configure mirror settings:

1.

2
3.
4

10.

1.
12.

13.

Navigate to the Tools & Monitors > Packet Monitor page.
Select the General tab.
Select the Mirror tab.

In the Mirror Settings section, type the desired maximum mirror rate into the Maximum mirror rate (in
kilobits per second) field. If this rate is exceeded during mirroring, the excess packets are not mirrored and
are counted as skipped packets. This rate applies to both local and remote mirroring. The default and
minimum value is 100kbps, and the maximum is 1Gbps.

Select Mirror only IP packets to prevent mirroring of other Ether type packets, such as ARP or PPPoE. If
selected, this option overrides any non-IP Ether types selected on the Monitor Filter view.

In the Local Mirror Settings section, select the destination interface for locally mirrored packets in the
Mirror filtered packets to Interface (NSA platforms only) drop-down menu.

In the Remote Mirror Settings (Sender) section, in the Mirror filtered packets to remote SonicWall
firewall (IP Address) field, type the IP address of the remote SonicWall to which mirrored packets are
sent.

@ | NOTE: The remote SonicWall network security appliance must be configured to receive the mirrored
packets.

In the Encrypt remote mirrored packets via IPSec (preshared key-IKE) field, type the preshared key
to be used to encrypt traffic when sending mirrored packets to the remote SonicWall network security
appliance. Configuring this field enables an IPSec transport mode tunnel between this appliance and the
remote SonicWall network security appliance. This pre-shared key is used by IKE to negotiate the IPSec
keys.

In the Remote Mirror Settings (Receiver) section, in the Receive mirrored packets from remote
SonicWall firewall (IP Address) field, type the IP address of the remote SonicWall network security
appliance from which mirrored packets are received.

@ | NOTE: The remote SonicWall network security appliance must be configured to send the mirrored
packets.

In the Decrypt remote mirrored packets via IPSec (preshared key-IKE) field, type the pre-shared key
to be used to decrypt traffic when receiving mirrored packets from the remote SonicWall network security
appliance. Configuring this field enables an IPSec transport mode tunnel between this appliance and the
remote SonicWall network security appliance. This pre-shared key is used by IKE to negotiate the IPSec
keys.

Select the interface from the Send received remote mirrored packets to Interface (NSA platforms
only) drop-down menu to mirror received packets to another interface on the local SonicWall network
security appliance.

Select Send received remote mirrored packets to capture buffer to save received packets in the local
capture buffer. This option is independent of sending received packets to another interface, and both can
be enabled.

To save your settings and exit the configuration window, click Save.
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Topics:

Starting and Stopping Packet Mirror

Starting and Stopping Packet Mirror

You can start a packet mirroring session that uses your configured mirror settings. On the MONITOR | Tools &
Monitors > Packet Monitor page, click Start Mirror. It is not necessary to first configure specific criteria for
display, logging, FTP export, and other settings. Packet mirroring stops when you click Stop Capture.

J Captured Packets ‘ General Statistics
¥ | Q search. (w) Stop Capture () Start Miror
| GEMERAL | INTERFACE |

Monitoring Captured Packets

The Captured Packets page provides several buttons for general control of the packet monitor feature and
display.

¢ Monitor All — Resets current monitor filter settings and advanced page settings so that traffic on all local
interfaces is monitored. A confirmation dialog box displays when you click this button.

e Monitor Default — Resets current monitor filter settings and advanced page settings to factory default
settings. A confirmation dialog box displays when you click this button.

e Clear — Clears the packet monitor queue and the displayed statistics for the capture buffer, mirroring, and
FTP logging. A confirmation dialog box displays when you click this button.

The other buttons and displays on this page are described in these sections:
e Starting and Stopping Packet Capture
e Starting and Stopping Packet Mirror

Starting and Stopping Packet Capture

You can start a packet capture that uses default settings without configuring specific criteria for packet capture,
display, FTP export, and other settings. If you start a default packet capture, the SonicWall network security
appliance captures all packets, except those for internal communication, and stops when the buffer is full or when
you click Stop Capture.

To manage packet captures, navigate to MONITOR | Tools & Monitor > Packet Monitor and select the
Captured Packets tab:
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¢ To set the statistics back to zero, click Clear.

e To start the packet capture click Start Capture.

e To stop the packet capture, click Stop Capture.

Viewing Packet Monitoring Statistics

The Statistics page displays status indicators for packet capture (trace), mirroring, and FTP logging. Information
pop-up tooltips display the configuration settings.

Topics:

e Capture Statistics
¢ Local Mirror Statistics

¢ Remote Mirror TX Statistics

¢ Remote Mirror RX Statistics

FTP Statistics

¢ Current Buffer Statistics

Capture Statistics

Navigate to the MONITOR | Tools & Monitor > Packet Monitor page and select the Statistics tab.

Captured Packets General | Statistics

CAPTURE STATISTICS

Y Trace active (D
buffer size 000 KB
9909 packets captured
buffer is 100% full

0 MB of buffer lost

Receiving from: 0.0.0.0

0 mirror packets revd

CURRENT CONFIGURATIONS

Filters

| REMOTE MIRROR RX STATISTICS

Remote mirroring Rx off (5)

0 mirror packets revd but skipped

Genersl (@  Loggng @

| LOCAL MIRROR STATISTICS

Local mirroring off (0
mirroring to interface: NONE
0 packets mirrored

0 pts skipped

0 pkis exceeded rate

| FesTaTsTICS

FTP Iogging off (&
FTP server pass/failure count: 0/0
FTP Thread is lole

Buffer is FULL

Mirraring @

| REMOTE MIRROR TX STATISTICS

Remate mirroring Tt off (&)
mirroring to: 0.0.0.0

0 packets mirrored

0 pits skipped!

0 pkis exceeded rate

CURRENT BUFFER STATISTICS

2899 dropped ()
151 forwarded
3568 consumed
3291 generated

0 unknawn

In the Capture Statistics section, Trace shows one of the following three conditions:
e Red - Capture is stopped

e Green — Capture is running and the buffer is not full

¢ Yellow — Capture is on, but the buffer is full

The Capture Statistics section also displays:
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CAPTURE STATISTICS

Trace active @
buffer size 8000 KB
9909 packets captured
buffer is 100% full

0 MB of buffer lost

(@ | NOTE: Although the buffer wrap option clears the buffer upon wrapping to the beginning, this is not
considered lost data.

Local Mirror Statistics

Navigate to the MONITOR | Tools & Monitor > Packet Monitor page and select the Statistics tab. The Local
Mirror Statistics section displays this information about packets sent to another physical interface on the same
SonicWall network security appliance:

| LOCAL MIRROR STATISTICS

Local mirroring off @
mirroring to interface: MNONE
0 packets mirrored

0 pkts skipped

0 pkts exceeded rate

¢ The status indicator shows one of the following three conditions:
* Red — Mirroring is off
e Green — Mirroring is on
* Yellow — Mirroring is on but disabled because the local mirroring interface is not specified
e On/off indicator
e Mirroring to interface — The specified local mirroring interface
e packets mirrored — The total number of packets mirrored locally

e pkts skipped — The total number of packets that skipped mirroring because of packets that are
incoming/outgoing on the interface on which monitoring is configured

e pkts exceeded rate — The total number of packets that skipped mirroring because of rate limiting

Remote Mirror TX Statistics

Navigate to the MONITOR | Tools & Monitor > Packet Monitor page and select the Statistics tab. The
Remote Mirror TX Statistics status indicator shows the following:
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| LOCAL MIRROR STATISTICS

Local mirroring off @
mirroring to interface: MONE
0 packets mirrored

0 pkts skipped

O pkts exceeded rate

Red — Mirroring is off

Green — Mirroring is on and a remote SonicWall network security appliance IP address is configured

Yellow — Mirroring is on but disabled because the remote device rejects mirrored packets and sends port

unreachable ICMP messages

It also displays these statistics:

On/off indicator
Mirroring to — The specified remote SonicWall IP address

packets mirrored — The total number of packets mirrored to a remote SonicWall network security
appliance

pkts skipped — The total number of packets that skipped mirroring because of packets that are
incoming/outgoing on the interface on which monitoring is configured

pkts exceeded rate — The total number of packets that failed to mirror to a remote SonicWall network
security appliance, either because of an unreachable port or other network issues

Remote Mirror RX Statistics

Navigate to the MONITOR | Tools & Monitor > Packet Monitor page and select the Statistics tab.Remote
Mirror RX Statistics track the packets received from a remote SonicWall network security appliance.

| REMOTE MIRROR RX STATISTICS

Remote mirroring Rx off @
Receiving from: 0.0.0.0
0 mirror packets rcvd

0 mirror packets rovd but skipped

The status indicator shows one of these conditions:

Red — Mirroring is off

Green — Mirroring is on and a remote SonicWall IP address is configured

It also displays these statistics:

On/off indicator
Receiving from — The specified remote SonicWall IP address

mirror packets rcvd — The total number of packets received from a remote SonicWall appliance
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mirror packets rcvd but skipped — The total number of packets received from a remote SonicWall
appliance that failed to get mirrored locally because of errors in the packets

FTP Statistics

Navigate to the MONITOR | Tools & Monitor > Packet Monitor page and select the Statistics tab. FTP
Statistics displays the following information:

| FTP STATISTICS

FTP logging off @
FTP server pass/failure count: 0/0
FTP Thread is Idie

Buffer is FULL

Red — Automatic FTP logging is off
Green — Automatic FTP logging is on

Yellow — The last attempt to contact the FTP server failed, and logging is now off

To restart automatic FTP logging, see Restarting FTP Logging on page 85.

It also displays these statistics:

On/off indicator

FTP Server Pass/Failure count — the number of successful and failed attempts to transfer the buffer
contents to the FTP server

FTP Thread is Busy/ldle — the current state of the FTP process thread

Buffer status — the status of the capture buffer

If automatic FTP logging is off, either because of a failed connection or simply disabled, you can restart it in
Configure > Logging.

To restart FTP logging:
1. Navigate to the Tools & Monitors > Packet Monitor page.
2. Selectthe General tab.
3. Selectthe Logging tab.
4. Verify that the settings are correct for each item on the page. (Refer to Configuring Logging Settings for
more information.)
5. Tochange the FTP logging status page to active, select Log To FTP Server Automatically.
6. Optionally, test the connection by clicking Log Now.
7. To save your settings and exit the dialog, click Save.

SonicOS 8 Monitor Administration Guide
Using Packet Monitor

122



Current Buffer Statistics

Navigate to the MONITOR | Tools & Monitor > Packet Monitor page and select the Statistics tab. The
Current Buffer Statistics summarizes the number of each type of packet in the local capture buffer:

CURRENT BUFFER STATISTICS

2899 dropped (D)
151 forwarded
3568 consumed
3291 generated

0 unknown

e Dropped — number of dropped packets

e Forwarded — number of dropped packets
e Consumed — number of dropped packets
e Generated — number of dropped packets

¢ Unknown - number of unidentified packets
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Viewing Connections

Your SonicWall network security appliance maintains a connections log for tracking all active connections to the
SonicWall network security appliance.

To view the Connections table:

1. Navigate to MONITOR | Tools & Monitors > Connections.

2. Click IPv4 or IPv6 to view the connections for that IP type.

The column names for the table are described in the following:

Src MAC
Src Vendor
Src IP

Src Port
Dst MAC
Dst Vendor
Dst IP

Dst Port
Protocol
Src Iface
Dst Iface
Flow Type
IPS Category
Expiry (sec)
Tx Bytes
Rx Bytes
Tx Pkts

Rx Pkts
Flush

MAC address of the source device.

Manufacturer of the source device.

IP address of the source device.

Port number of the source device.

MAC address of the destination device.

Manufacturer of the destination device.

IP address of the destination device.

Port number of the destination device.

Protocol used for the connection, such as TCP or ICMPV6.

Interface on the source device.

Interface on the destination device.

Flow type of the connection, such as generic or HTTP Management.
Type of Intrusion Prevention System (IPS) used; N/A = Not Available.
Number of seconds remaining before the connection expires.
Number of bytes transferred.

Number of bytes received.

Number of packets transferred.

Number of packets received.

Contains the Flush icon for each entry.
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Topics:

* Filtering the Connection Log
e Connections Log Functions

Searching the Connections

Use Filter to find connections that meet specific search criteria.

1. Click the Filter icon.

2. Enable the filter options you want.

3. Click Apply Filters. You are asked to confirm your choice. Once the filter is applied, the table updates.

Filtering the Connection Log

Filter the Connections table so it displays only those connections matching the criteria specified in the Filter
option.

Filter by
» Source IP
e Destination IP
* Destination Port
* Protocol
¢ Flow Type
» Source Interface
* Destination Interface
Filter Logic displays how the filter is applied.

The fields you enter values into are combined into a search string with a logical AND. For example, if you enter
values for Source IP and Destination IP, the search string looks for connections matching:

Source IP AND Destination IP
Check the Group box next to any two or more criteria to combine them with a logical OR. For example, if you

enter values for Source IP, Destination IP, and Protocol, and check Group next to Source IP and Destination
IP, the search string looks for connections matching:
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(Source IP OR Destination IP) AND Protocol

e Click Apply Filters to apply the filter immediately to the Active Connections table.
e Click Reset Filters to clear the filter and display the unfiltered results again.

e Click Export, and select if you want the results exported to a plain text file, or a Comma Separated Value
(CSV) file for importing to a spreadsheet, reporting tool, or database. If you are prompted to Open or Save
the file:

1. Select Save.

2. Enter afilename and path.

3. Click OK.

Connections Log Functions

EVENT LOG FUNCTIONS

Function Action

IPv4/IPv6 The Connection Log is configured the same for IPv6 and IPv4. To change the
view, select the IP version from the drop-down menu. IPv4 is the default.

Refresh Click to immediately refresh the Event Log.

Export to file Exports the data to an external file. From the drop-down menu, select the file

format: CSV, Text, or Email.

Clear Deletes all logs displayed in the Event Log. You are asked to confirm your
decision before the events are deleted.

Flush Click this icon to flush that connection from the table. This option is found in the
far right column of the table.
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Monitoring Core 0 Processes

The Core 0 Processes page shows the individual system processes on core 0, their CPU utilization, and their

system time.

@

WIS / Monitor / Tools &Monitors / Core 0 Processes.

10

1

1:

1

1

1

1

3

11

1

2

2

2

2

NAME
sonicosv
tGhicMon
tGhicPrese.ect
tpsuProbeTask
tASFIRWT
t3rdAppHandier
dhepesinotify
tsarc
tWIbDnsLkp
tSchedObjTimer
tNetMon
tNetMonXmit
tTimerTask
tMsTimerTask
tNSecsTimerTask
veControl
tHandleNetink
tSpoofTask
tSpoofArpTask
doudSyncTask

tsfGenTask

PRIORITY

Task Total
de

System

TOTAL (SECS)
41555
1245
208.03
8035

8047

8160

7672

7672

7598
1202428
482575.66

1561103

Configuration (CJfJ) Non-Config
() Refresh

CURRENT % & CURRENT (SECS)
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000
000 000

208 003

9490 155

300 005
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Using Packet Replay

Packet replay is an integrated tool to firewall for testing and debugging purposes. You can replay packets in these
ways:

Craft a packet Specify packet header fields and payload, one by one, through the
management interface.

Use packet buffer Input packet data (both header and payload) or just copy from other places and
paste it.

Replay Pcap file Replay a sequence of packets stored in a Pcap file.

Replayed packets are restrained from traveling outside this firewall; they are dropped before transmitting through
interfaces.

Topics:

¢ Single Packets
* Replay Pcap File
e Captured Packets

Single Packets

These procedures describe how to craft a packet for analysis. Some fields may change when the IP Type is
changed.

Topics:

e Packet Crafting
e Packet Buffer

Packet Crafting

The following procedure uses IP Type = UDP.
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To craft a packet:

1.

2
3.
4

7.
8.

Navigate to MONITOR > Tools &Monitor > Packet Replay.

Click Single Packet.

Choose Packet Crafting.

Enter the following information; options change depending on your selection for IP Type:

IP TYPE = UDP

Field

Receiving Interface
Destination MAC
Source MAC

Ether Type

IP Type

Source IP
Destination IP

TTL

Source Port

Destination Port

Definition

Select the interface from which the packet is received.
Enter the destination MAC address.

Enter the source MAC address.

Select the protocol type. The defaultis IPv4.

Select UDP.

Enter the source IP address.

Enter the destination IP address.

Enter the IP header.

Enter the UDP source port number.

Enter the UDP destination port number.

If you select IP Type = ICMP, these fields are different from UDP:

IP TYPE = ICMP

Field Definition

ICMP Type  Select Echo Request or Echo Response from the drop-down menu.

ID Type in the ICMP identifier.

Sequence Type in the ICMP sequence number.

If you select IP Type = IGMP, these fields are different from UDP:

IP TYPE = IGMP

Field Definition

IGMP Type Select IGMP Type from the drop-down menu. The default is Membership
Query.

Max Response  Type in the IGMP maximum response timeout. Enter the value in seconds.

Group IP Type in the group IP address for the query.

Address

In the Payload field, enter or copy the payload hex data.

Click Send.

The crafted packet is sent to the firewall engine.
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Packet Buffer

To build a packet buffer:

1. Navigate to MONITOR > Tools &Monitor > Packet Replay.
Click Single Packet.
Choose Packet Buffer.
From Receiving Interface, select the interface to receive the data.
Enter the Packet Buffer data, in hex.
Click Send.

o g M w D

The crafted packet is sent to the firewall engine.

Replay Pcap File
The Pcap filter can be defined by IP address or MAC address.

Topics:

* Replaying an IP Pcap File
« Replaying a MAC Pcap File

Replaying an IP Pcap File

To define by IP:
1. Navigate to MONITOR > Tools &Monitor > Packet Replay.
2. Click Packets from File.
3. Click IP. Two IP filters are provided.

4. Foreach IP filter, complete the following:

Field Definition
IP Enter the destination address to be looked up.
Address

Receiving Select the receiving interface. The IP packets that have the destination address listed in
Interface IP Address are assumed to arrive from the interface selected in this option.

New IP If enabled (the option is selected), the new IP address listed in this field replaces the
Address filtered destination IP address when replaying the packets.
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5. To search for and select a Pcap file to be replayed. click Choose File.
e To upload the selected file, click Upload.
e Toreplay the packets in the uploaded Pcap file, click Replay.

e When done, to delete the uploaded file, click Delete.

Replaying a MAC Pcap File

To define by Mac address:
1. Navigate to MONITOR > Tools &Monitor > Packet Replay.
2. Click Packets from File.
3. Click MAC. Two IP filters are provided.
4

For each IP filter, complete the following:

Field Definition
MAC Enter the destination address to be looked up.
Address

Receiving Select the receiving interface. The IP packets that have the destination address listed in
Interface MAC Address are assumed to arrive from the interface selected in this option.

New IP If enabled (the option is selected), the new IP address listed in this field replaces the
Address filtered destination IP address when replaying the packets.

5. To search for and select a Pcap file to be replayed. click Choose File.
e To upload the selected file, click Upload.
e Toreplay the packets in the uploaded Pcap file, click Replay.

e When done, to delete the uploaded file, click Delete.

Captured Packets

Captured and replayed packets are displayed on the Captured Packets page. It provides three sections to
display different views of captured packets:

* About Captured Packets
* Packet Detail
e Hex Dump

To view the list of captured packets:

1. Navigate to MONITOR > Tools &Monitor > Packet Replay.
2. Click Captured Packets.
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Use these options to manage the Captured Packets:

Clear
Export
Reload

Grid
Settings

Clears the packet monitor queue and the displayed statistics for the capture buffer, mirroring,
and FTP logging.

Exports the file in the format you select from the drop-down menu. Saved files are placed on
your local management system.

Refreshes the packet display windows on this page to show new buffer data.

Allows you to customize which columns are displayed.

About Captured Packets

The Captured Packets page displays these statistics about each packet:

e #-The packet number relative to the start of the capture.

e Date & Time - The date and time that the packet was captured.

¢ Ingress - The firewall interface on which the packet arrived is marked with an asterisk (*). The subsystem
type abbreviation is shown in parentheses. Subsystem type abbreviations are defined as:

Abbreviation Definition

i Interface

he Hardware-based encryption or decryption
sc Software-based encryption or decryption
m Multicast

r Packet reassembly

s System stack

ip IP helper

f Fragmentation

e Egress - The firewall interface on which the packet was captured when sent out. The subsystem type
abbreviation is shown in parentheses.

Abbreviation Definition

i Interface

hc Hardware-based encryption or decryption
sc Software-based encryption or decryption
m Multicast

r Packet reassembly

s System stack

ip IP helper
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Abbreviation Definition

f Fragmentation

e Source IP - The source IP address of the packet.

e Destination IP - The destination IP address of the packet.

e Ether Type - The Ethernet type of the packet from its Ethernet header.

e Packet Type - The type of the packet depending on the Ethernet type; for example:

Ethernet type Packet type

IP packets TCP, UDP, or another protocol that runs over IP
PPPoE packets PPPoE Discovery or PPPoE Session

ARP packets Request or Reply

e Ports [Src, Dst] - The source and destination TCP or UDP ports of the packet.

* Length [Actual] - Length value is the number of bytes captured in the buffer for this packet. Actual value,
in brackets, is the number of bytes transmitted in the packet.

» Status - The status field for the packet.

The Status field shows the state of the packet with respect to the firewall. A packet can be dropped,
generated, consumed, or forwarded by the firewall. Position the mouse pointer over dropped or consumed

packets to show this information:

Packet Status Displayed Value

Dropped Module-ID = <integer>
Drop-code = <integer>
Reference-ID: <code>

Consumed Module-ID = <integer>

Packet Detail

Definition of Displayed Value
Value for the protocol subsystem ID
Reason for dropping the packet
SonicWall-specific data

Value for the protocol subsystem ID

When you click a packet on the Captured Packets page, the packet header fields are displayed on the Packet
Detail page. The display varies depending on the type of packet that you select.

Hex Dump

When you click a packet in the Captured Packets page, the packet data is displayed in hexadecimal and ASCII

format on the Hex Dump page.

e The hex format is shown on the left side of the window, with the corresponding ASCII characters displayed

to the right for each line.

e When the hex value is zero, the ASCII value is displayed as a dot.
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SonicWall Support

Technical support is available to customers who have purchased SonicWall products with a valid maintenance
contract.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a
day, 365 days a year.

The Support Portal enables you to:
¢ View Knowledge Base articles and Technical Documentation
¢ View and participate in the Community Forum discussions
* View Video Tutorials
e Access MySonicWall
e Learn about SonicWall Professional Services
¢ Review SonicWall Support services and warranty information

e Register at SonicWall University for training and certification
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https://www.sonicwall.com/support/contact-support/
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https://www.sonicwall.com/search/#t=Support&sort=relevancy&f:sourceTypeFacetId=[Knowledge Base]&f:@language=[English]
https://www.sonicwall.com/support/technical-documentation/?language=English
https://community.sonicwall.com/technology-and-support
https://www.sonicwall.com/support/video-tutorials/#t=All&sort=relevancy&numberOfResults=12
https://platform.sonicwall.com/
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